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Introduction

Apple builds products that enable creative professionals to focus on what matters
most to them: being creative. With Mac OS X v10.3 “Panther,” Apple has introduced a
new level of power and productivity for the creative pro. Mac OS X offers unprece-
dented stability, speed, and graphics support. With Mac OS X, creative professionals
can express their imaginations with greater ease and integration into their unique
workflow than ever before.

This document will help you make a smooth transition to Mac OS X from your current
Mac OS 9–based system. It describes Mac OS X upgrade options, with step-by-step
instructions for implementing them. It also offers recommendations for setting up
your new Mac OS X system efficiently for design and printing projects.

Mac OS X is easy to learn—and it provides significant benefits over earlier Macintosh
operating systems. With the release of Mac OS X Panther, there’s never been a better
time to upgrade. Panther delivers the stability and performance that have made Mac
OS X renowned, along with exciting new graphics, collaboration, user interface, and
digital media features.

• A robust UNIX-based foundation provides outstanding reliability. It also brings dramatic
productivity benefits by running multiple applications and tasks faster, and by taking
care of memory management for you.

• Mac OS X can convert PostScript to PDF for screen display and printing. Now other
computers on your network can send PostScript files to your Macintosh, which can
convert the files, rasterize the documents, and print them on a USB printer. The ability
to share a USB raster printer as a PostScript printer on the network is an industry first.

• A “Save As PDF” button lets you instantly create PDF files in any Mac OS X application.
And you can view them with Preview, the fastest PDF viewer application on any 
platform.

• Quartz filters provide professional-level transformation and manipulation to enhance
your PDF files. These filters can be used to manage color, create special color effects,
alter image data, or create PDF files suitable for professional publishing workflows.

• Broad support for multiple font formats and built-in font management allow you to
create the exact typographical look you need for each project.

• Support for Unicode text encoding lets you work in multiple languages even within a
single document and take advantage of fonts with rich character sets.

• Enhancements to the Finder allow you to navigate through your files and folders
faster than ever.
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• Exposé is a major advance in user interface design that will change the way you work
with multiple files, applications, and projects.

• Printer Setup Utility consolidates print management into one application.

• Standard protocols for file sharing, printing, and other services enable you to collaborate
more smoothly with users of Windows-based computers and to preserve your invest-
ment in printers and other devices.

• A full complement of multimedia applications, including iChat AV for real-time 
text-based chats as well as audio and video conferencing, and the iLife suite—iPhoto,
iTunes, iMovie, and iDVD—for versatile digital media capabilities.

• A full set of tools for developing Mac OS X applications is included at no additional
charge.

More than 10,000 applications—including QuarkXPress, the Adobe Creative Suite, and
other favorites of creative professionals—now take advantage of the powerful capabil-
ities of Mac OS X. And the Classic environment in Mac OS X lets you run the Mac OS 9
applications you depend on until you’re ready to move to versions written for Mac OS X.

Whether you’re upgrading your existing Mac or moving to a new Mac, simply follow
the easy instructions in this guide, and you’ll be enjoying the benefits of Mac OS X in
no time!

Which Transition Path Should I Take?
If you are planning to install Mac OS X on a Mac with an earlier operating system (Mac
OS 9 or a previous version), you should read the section “Upgrading an Existing Mac.”

If you have been using a computer with Mac OS 9 (or a previous version of the 
Mac OS) and you now have a new Mac that has Mac OS X preinstalled, you should
read “Moving to a New Mac” to learn how to smoothly transfer your applications 
and files to the new system.

For your convenience, a Migration Checklist (Appendix I) is provided to ensure that
you don’t miss any steps in the upgrade process.

Once you’ve upgraded to Mac OS X, read the section called “Mac OS X Basics” to get
acquainted with the new features of Mac OS X. Refer to the appendixes for useful
information on font management, formatting your hard disk, Mac OS 9 to Mac OS X
quick references, supported devices, system maintenance, troubleshooting, and work-
ing with a multiuser system.
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Upgrading an Existing Mac

Use this path if you want to install Mac OS X on a Mac OS 9 computer. The Migration
Checklist in Appendix I will aid you in completing all the necessary steps.

You can choose to keep your existing files (and even Mac OS 9, if you wish) on the
hard drive or to erase the drive and perform a fresh installation of Mac OS X and 
your applications. Both ways work and are covered in the steps in this section. These
instructions assume that you have had some experience using Mac OS 9.

After your transition, you’ll want to familiarize yourself with Mac OS X. We recommend
that you read the section called “Mac OS X Basics” and the subsequent sections on
printing, fonts, and other common tasks.

In this section, you’ll perform the following actions:

1. Evaluate your computer and peripherals. (See “Evaluating Your Hardware,” page 7.)

2. Evaluate your applications. (See “Evaluating Your Software,” page 8.)

3. Record your current network settings. (See “Recording Your Mac OS 9 Network 
Settings,” page 10.)

4. Record your current email settings. (See “Recording Your Mac OS 9 Email Settings,”
page 12.)

5. Back up your files. (See “Backing Up Your Files,” page 13.)

6. Update Mac OS 9, if needed. (See “Updating Mac OS 9,” page 13.)

7. Install Mac OS X. (See “Installing Mac OS X,” page 14.)

8. Enter your network and email settings. (See “Entering Your Recorded Settings,”
page 17.)

9. Install the applications you want to use in Mac OS X. (See “Migrating Your
Applications,” page 17.)

10. Reinstall your files, if you performed a disk reformatting during this process. Even if
you haven’t reformatted the disk, you may want to consider moving some of your 
files to new locations, especially if you’ll be using them with Mac OS X applications.
See the section “Organizing Your Files” on page 29 for information on storing your 
files efficiently in Mac OS X.
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Evaluating Your Hardware
Mac OS X version 10.3 “Panther” runs on Macintosh computers with a PowerPC G3, G4,
or G5 processor and a built-in USB port. To make sure your computer is ready for Mac
OS X, you must have:

• At least 128MB of physical RAM; 1GB recommended for professional publishing

• A built-in display or a display connected to an Apple-supplied video card (most other
video cards sold for Mac systems should also work with Mac OS X; check with the
manufacturer)

• At least 2GB of disk space; 8GB recommended for creative environments

Apple does not support Mac OS X on systems that have processor upgrade cards. You
will need to remove the card or use a different Mac that can run Mac OS X without an
upgrade card.

Checklist item 1 in Appendix I will help you evaluate your Macintosh system, and item
2 covers third-party hardware and peripherals.

Third-party hardware and peripherals
Thousands of products from Canon, Nikon, HP, Sony, LaCie, Epson, Lexmark, 3M, Kodak,
Kensington, Logitech, and many other leading vendors are ready to work with Mac OS
X right out of the box. What external devices will you want to use with your upgraded
Macintosh computer? These are the most common ones used in design and print work:

• Printers
• Scanners
• Removable storage devices
• Digital cameras
• Audio devices (microphones, speakers, other devices)
• Video cards
• CD burners
• PDAs
• SCSI add-in cards

Mac OS X features an advanced I/O system based on established open standards so
that it can support the entire spectrum of peripherals used by design professionals. It
comes configured with support for many camcorders, digital cameras, storage devices,
scanners, printers, and input devices. See Appendix B for links to up-to-date lists of
peripherals that are directly supported in Mac OS X.

Some products may require third-party drivers that have been adapted to take 
advantage of Mac OS X. Information on driver availability can be obtained directly
from the manufacturer or from the Apple downloads site at www.apple.com/
downloads/macosx/drivers.

Use checklist item 2 to record the information you find out from your hardware 
evaluation.
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Evaluating Your Software
More than 10,000 applications specifically built for Mac OS X are already available 
and in use. This section helps you evaluate the software most often used by creative
professionals to determine whether you need to obtain upgrades or new versions 
of any of your current applications. You may also want to read the information at
www.apple.com/macosx/applications or check for other Mac OS X design and print
programs at guide.apple.com/design.

Types of Mac OS X applications
Most Macintosh developers have either created all-new Mac OS X applications or have
added Mac OS X compatibility to existing Mac OS 9 programs. Software written before
the release of Mac OS X can be run in the Classic environment of Mac OS X.

• Applications optimized for Mac OS X. To get the maximum benefits of Mac OS X,
you should use applications that have been designed to take full advantage of 
features in Mac OS X such as preemptive multitasking and automatic memory 
management. Some of the applications you are currently running in Mac OS 9 may 
fall into this category and should run perfectly in the Mac OS X environment.

• Classic applications. Other applications—those written before the release of Mac 
OS X—should run fine in the Classic environment of Mac OS X. They don’t need to be
reinstalled after you upgrade your computer to Mac OS X; simply double-click one to
launch Classic.

Even if your older software runs in Mac OS X, you may want to take this opportunity
to upgrade to the latest version. To find out whether your applications are optimized
for Mac OS X, you can try running them on a Mac OS X computer or check with the
application’s developer.

Image editing and page assembly software
QuarkXPress, Adobe Photoshop, Adobe Illustrator, Adobe InDesign, Macromedia
FreeHand, and most other creative applications are now available in native Mac OS X
versions to help you work more productively than ever. Check with the developers 
of your applications to find out whether they have been upgraded. If not, you should
be able to use your Mac OS 9 versions in the Classic environment.

A number of popular third-party plug-ins and extensions that add features to Adobe
Acrobat, Adobe InDesign, QuarkXPress, and other applications have already been
updated for Mac OS X, and others are under development. Check with the vendors 
for their current status.

See checklist item 3 when you evaluate your image editing and page assembly software.

Font management software
If you have been using Mac OS 9 versions of professional font management applica-
tions such as Extensis Font Reserve, Extensis Suitcase, or Insider Software FontAgent
Pro, your transition will be easy, because the Mac OS X versions will be familiar to you.
In some cases, the software you’re already using on Mac OS 9 will also run on Mac OS
X. Check the system requirements on the software package or contact the vendor for
details. Note that Adobe Type Manager Deluxe is not available for Mac OS X. Please
see the “Extensions and control panels” section for more information.

Mac OS X includes a built-in application for managing fonts called Font Book. For
more information about Font Book, see Appendix G.

Use checklist item 4 to help you evaluate this category.
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Internet applications
Mac OS X ships with a full-featured email application called Mail. Mail can import 
mailboxes from various email applications, including Entourage, Outlook Express, Claris
Emailer 2.0v3, Netscape 4, and Eudora, so switching to it is straightforward. In addition,
most third-party email applications have been updated to run natively in Mac OS X.
So if you prefer to keep using your current email program, it’s most likely available 
in a Mac OS X version. Check the vendor’s website for details. With the release of Mac
OS X v10.3, Mail works with Microsoft Exchange mail servers, so you can access your
Exchange mail account from either a Windows or Macintosh computer.

Also included in Mac OS X is a fast, versatile, and innovative web browser called Safari.
You can import existing bookmarks from popular Mac OS 9 browsers into Safari, so
you may want to switch to Safari instead of upgrading your existing browser.

You can record the results of your Internet software analysis in checklist item 5.

Business applications
Microsoft Office v. X for Mac brings the new look and capabilities of Mac OS X to your
favorite Microsoft productivity applications. You can use your existing Word, Excel, and
other documents in this new version of Office.

Financial applications such as Quicken, QuickBooks, and MYOB are also available in
Mac OS X versions.

The SimpleText editor included with Mac OS 9 has been replaced in Mac OS X by the
more versatile TextEdit application.

Business applications are covered in checklist item 6.

Extensions and control panels
One of the advantages of Mac OS X is that you no longer have to worry about system
extensions and control panels conflicting with each other, because Mac OS X doesn’t
have them. If you desire specific functionality offered by any of your old extensions,
check whether Mac OS X has the equivalent feature built in. If it doesn’t, check with the
developers of your extensions to see whether they offer similar software for Mac OS X.

If you plan to use the Classic environment on your new Mac OS X system, you’ll want
to go through your Mac OS 9 extensions and control panels to determine which ones
you’ll need so that you can copy them to the new system when you migrate. Here 
are some of the extensions most often used by design and print professionals, with
information about whether you need to use them in Mac OS X:

Adobe Type Manager (ATM) and ATM Light are no longer needed because Mac OS X
has a built-in font rasterizer.

Adobe Type Manager Deluxe is not available for Mac OS X. There are several options
for this functionality. Mac OS X v10.3 has the built-in Font Book application, which
allows you to store all of your fonts in one tool and then build collections (sets) of
those fonts for various needs. There are also other font management applications with
more sophisticated features; see Appendix H for information.

Windows connectivity extensions are not necessary in Mac OS X because it has
built-in support for Windows and UNIX connectivity. Files from other operating 
systems can be accessed from the Network icon in a Finder window or from the 
Go menu in the Finder. When you access the network in this way, shared items 
automatically show up in your Network browser. See Appendix H for information 
on third-party Mac and Windows networking solutions.
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Importing bookmarks into Safari
The first time you open Safari, it automatically
imports bookmarks from Microsoft Internet
Explorer, Netscape Navigator, and Mozilla.

If you are using a web browser other than
those mentioned, you may be able to move
your bookmarks to Safari by exporting them
from your browser as an HTML document.
Then open the document in Safari and open
your Bookmarks Library in a separate window.
Drag the links from the first window to a 
collection in your Bookmarks Library.



File sharing on a Mac OS X client is simple and can be turned on in a single prefer-
ence pane. If you want more advanced sharing services, take a look at Mac OS X
Server. Third-party solutions are available for peer-to-peer file sharing; see Appendix H
for information.

Extensions managers are not needed in Mac OS X because it does not use extensions.

Use checklist item 7 to make sure that you’ve evaluated all of your extensions and
control panels.

AppleScript scripts
AppleScript is fully supported in Mac OS X. In fact, Mac OS X v10.3 ships with dozens
of useful preinstalled scripts. Using AppleScript Studio software, you can easily create
powerful Mac OS X applications written entirely in AppleScript that have the beautiful
Mac OS X interface.

Some of your existing AppleScript scripts may need to be modified to work properly
on Mac OS X, so you’ll want to test them once you’ve made the transition.

For more information, visit www.apple.com/applescript.

Checklist item 8 gives you a place to note that you’ve evaluated your AppleScript scripts.

Recording Your Mac OS 9 Network Settings
If you’re planning to connect to a network or to the Internet through an ISP, you’ll
need to configure network settings in Mac OS X.

If you’ve been using DHCP to obtain a dynamic IP address on your Mac OS 9 system,
when you first run Setup Assistant for Mac OS X, it should be able to get all the 
information it needs automatically from your ISP’s DHCP server. (To find out whether
you’re currently using DHCP, go to the TCP/IP control panel and check the settings 
for each configuration.)

If you have a static IP address, use the instructions in this section to gather the network
configuration information from your current Mac so that you can set up networking
connections in Mac OS X.

Network information is stored in various locations in Mac OS 9 depending on the 
type of network connection. In the TCP/IP and Remote Access control panels, you can
switch between configurations by choosing Configurations from the File menu. When
checking your settings, remember to record the settings for all of the configurations
you use—not just the active one.
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TCP/IP. TCP/IP settings are stored in the TCP/IP control panel. You may have multiple
configurations that correspond to different locations in which you use your Mac, so be
sure to copy each one.

PPP. The settings for PPP—used for dial-up connections—are located in the 
Remote Access control panel. You may have multiple configurations, so be sure 
to copy each one.
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PPPoE. Mac OS 9 doesn’t support PPPoE (PPP over Ethernet), so if you’re using this
connection method (such as with DSL), its settings are probably stored in a third-party
application provided by your ISP. Mac OS X has built-in support for PPPoE, so you will
not need a special application to use it after your transition. Check your ISP’s website
for instructions on setting up PPPoE in Mac OS X.

An easy way to copy your settings is to make a screen capture of the window in which
they are displayed. To do this in Mac OS 9, press Command–Shift–Caps Lock–4, then
click the window you want to record. The picture file appears on the top level of your
hard disk with the name Picture 1. Repeat as needed to capture your other settings
windows. You can open and print the pictures using SimpleText.

When you add Mac OS X to your Mac, Setup Assistant guides you through network
configuration the first time you start up the computer after installing Mac OS X.

You can record your network settings in item 9 of the checklist.

Recording Your Mac OS 9 Email Settings
To use your current email account with Mac OS X, you’ll need to copy some important
information about your account. That information includes your email address, pass-
word, account type (POP or IMAP), user name, and the names of the incoming and
outgoing mail servers your account uses. If you can’t find this information, check with
your Internet service provider.

When you install Mac OS X, the Setup Assistant application prompts you for your
email information. You can enter your settings then, or you can set up your account
later in Mac OS X Mail.

Locate your email settings by following these steps:

1. From the Mac OS 9 desktop, choose Control Panels from the Apple menu, then choose
Internet from the submenu that appears.

2. In the Internet window that appears, click the E-mail tab.

3. Write down all of your information from the E-mail Account Information pane. Note
whether you are using a POP or IMAP account.

• Email address: yourname@provider.com
• Account ID or account name: yourname (example: jsmith)
• Password: yourpassword
• Incoming mail server (examples: pop.provider.net, mail.provider.com)
• Outgoing mail server (examples: smtp.provider.net, relay.provider.com)

Tip: You can print your email settings by taking a “snapshot” of your Internet window.
To do this in Mac OS 9, press Command–Shift–Caps Lock–4, then click the Internet
window. Open your hard disk, locate the newest picture file, and then double-click to
open it. When the picture opens, choose Print from the File menu. You can open and
print the pictures using SimpleText.

Use item 10 of the checklist to record your email settings.

12Guide for Creative Professionals
Migrating to Mac OS X



Backing Up Your Files
If you plan to install Mac OS X on the same drive as your Mac OS 9 system, you 
probably don’t want to remove any existing files from the disk. Installing Mac OS X
should not affect your current files. However, it’s always a good idea to back up 
important files before making any major changes to a computer.

If you already have a backup solution in place, read the sidebar “Verifying your file 
system,” make a fresh backup, then proceed to the section “Updating Mac OS 9.”

Check off this step in item 11 of the checklist.

File backup utilities
File backup utilities make it easy to back up individual files, groups of files, or the
entire contents of your hard disk. They allow you to save your files on a number of
types of internal, external, and removable storage devices, including hard disks, tapes,
network servers, CDs, and DVDs.

At this point in the transition process, your backup utility will have to run in Mac OS 9.
However, in the long term you will want a backup utility that runs in Mac OS X.

A number of backup utilities can run in either version of the Mac OS. See Appendix H
for information.

If you prefer, you can transfer your files to another storage device manually. This
method is fine for data files, but it is not recommended for backing up your operating
system. Many invisible files are used by the operating system, so copying them using
the Finder can be risky.

What you should back up
When deciding which files are important and should be backed up for safety, consider
the following:

• Customer job files
• Fonts
• Letters and contracts
• Digital artwork, photographs, and scans
• Product serial numbers and license keys
• Email messages
• Address book information
• Checkbook data
• Invoices
• Browser bookmarks

Even if your disk is well organized, it can be easy to miss important files. If you are
worried about this, your best strategy is to back up everything on your disk—even if 
it means purchasing backup software and an external storage device.

Updating Mac OS 9 
If you want to use Classic applications, it’s important to make sure you have the latest
version of Mac OS 9 before installing Mac OS X. If your computer is connected to the
Internet, you can update your Mac OS 9 system software using the Software Update
control panel.

1. From the Apple menu, choose Control Panels, then choose Software Update.

2. In the Software Update window, click Update Now.

3. Install the updates.

This is part of item 11 on the checklist.
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Verifying your file system 
To ensure that your file system is in good
shape before you move files to your new 
system, you should run Disk First Aid, which
is part of the Disk Utility application. Disk
First Aid can verify and, if necessary, repair
the file system on your disk.

To run Disk First Aid, do the following:
1. Start up the computer from the Mac OS X

Disc 1 CD. (To start the computer from a CD,
press the “c” key after you hear the startup
chime and hold it until the Apple logo
appears.)

2. From the File menu, choose Open Disk Utility.
3. Select the First Aid tab.
4. Highlight the disk volume you want to repair

from the list of disks on the left side of the
Disk Utility window. (In the list, volumes have
names next to their icons; disks have sizes.)

5. Click Repair Disk.
6. When the repair is completed, scroll to the

bottom of the text box in the First Aid pane
to see the results.

7. If you see “The volume [your volume name]
appears to be OK,” you are finished and can
proceed with installing Mac OS X.

If there are problems, run Disk First Aid a 
second time. If problems persist, you will
need to reformat your disk as described in
Appendix F, “Formatting Your Hard Disk.”

If you perform this step, check it off in item
11 of the checklist.



Installing Mac OS X
Installing Mac OS X is easy. After it’s installed, it will guide you through setting up the
system to your preferences.

The Mac OS X Panther package includes three Mac OS X installation discs and one
Developer Tools CD, which features Apple’s Xcode developer tools. Depending on the
installation option you choose, you may be asked for any or all of the three installation
discs. Installation of the developer tools is optional.

Here’s all you need to do to get started:

1. Quit any open applications.

2. Insert the Mac OS X Panther Install Disc 1 CD into your computer.

3. Click the restart button on the Mac OS X screen that appears to restart your computer
and begin the installation process.

4. Select the language you are going to use.

Follow the Mac OS X Installer instructions described on the next pages. They will
guide you through the simple steps needed to install the software.

When you install Mac OS X, none of your existing files are overwritten. By default,
Mac OS X is installed in addition to Mac OS 9, not in place of it.

Installation steps and options
The Installer application will guide you through the installation process.

You can quit the installation any time before you press the final Install or Upgrade
button in the Installing step. To stop the installation, select Quit from the Installer
menu. You are presented with a confirmation dialog. Press Restart to stop the 
installation process.

To eject the CD, press and hold the mouse button right after you hear the startup
chime. Your disc ejects and your Mac restarts from your existing system.

Step 1: Introduction
Click Continue when you’re ready to proceed.

Step 2: Read Me
The Read Me file contains important compatibility information. Read through it to
make sure your system is compatible with the version of Mac OS X that you’re installing.
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Updating firmware
“Firmware” is software that resides 
permanently on your computer to control
various hardware components inside it.
You may need to update your firmware
before installing Mac OS X.

Look in the Firmware Updates folder 
located in the Utilities folder on your 
Mac OS X Installer CD to see whether an
update is included for your Mac. If your
Mac does need a firmware update, read
the About Firmware Update file for your
computer. This file contains information
about what the update does and gives
installation instructions.

You can also go to docs.info.apple.com/
article.html?artnum=86117 for a list of
Macintosh models that require a firmware
update before installing Mac OS X. Or you
can search www.info.apple.com/support/
downloads.html. For example, to find out
whether you need a firmware update for
your PowerBook G3 computer, use the
search feature to look for “PowerBook G3
firmware update.”



Step 3: License
Read the license agreement and click Continue. A dialog appears that contains the
buttons Agree and Disagree. If you click Agree, the installation continues. If you click
Disagree, the license agreement reappears. You must either agree to the license to
continue the installation or use the Installer menu to quit the Installer application.

Step 4: Select Destination
Click the icon of the volume on which you want to install Mac OS X. A green arrow
appears on the icon to indicate that you can install Mac OS X on the volume.

Once you have selected a volume, the Options button at the bottom of the window
becomes active. Click it to view various installation options. Because you have already
prepared your disk using instructions in this guide, accept the default option, Install
Mac OS X. Click OK to close the dialog, then click Continue to proceed to the next step.

Step 5: Installation Type
Select “Easy Install on <disk name>.”

You will see the message, “Click Install to perform a basic installation of this software
package on the volume <disk name>. The software you are installing requires additional
installation CDs so have them ready: Mac OS X Install Disk 2.”

You have the option to customize, go back, or install.

If you prefer to reduce the size of the installation, you can customize it by clicking the
Customize button. Otherwise, click Install.

If you have decided to customize, clicking Customize allows you to view a list of 
the available options. The Essential System Software must be installed; in fact, you
can’t uncheck their boxes. Leave the BSD Subsystem checked, too. The Additional
Applications package includes a number of useful Apple and third-party Mac OS X
programs. You should accept the default and allow these applications to be installed.

The only choices that you should consider changing are the following.

Fonts. Click the gray arrow on the left to see your choices:

• Fonts for Additional Languages. This is off by default. Selecting this option installs
fonts for non-Asian languages. If you will be working in multiple languages, select 
this option.

• Additional Asian Fonts. This option is on by default. If you know that you won’t be
using Asian fonts, you don’t need to install them and you can uncheck this box.

Printer Drivers. Click the gray arrow to see your printer driver choices. There are six
choices; all but one are selected by default. If you need a broader set of drivers, click
the disclosure triangle next to Additional Printer Drivers to view your choices. If you
know what printers you will be using, you can skip the drivers from other manufacturers
to save disk space. If you want to be able to print to many different types of printers
without having to install additional drivers later, choose to install all of the printer 
drivers. If you’re installing on a PowerBook or iBook, installing all of the drivers now
will allow you to connect to a number of different printers when you are on the road.

Language Translations. All languages are selected by default. Click the disclosure tri-
angle next to Language Translations to display a list of languages that will be support-
ed on your system. To save disk space and reduce installation time, you can deselect
languages that you know you won’t be using.

Easy Install. If you want to go back to the Easy Install choices, click Easy Install at the
bottom of the window. Once you are satisfied with your choices, click Install to install
Mac OS X.
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Step 6: Installing
In this step, the installation takes place.

Step 7: Finishing Up
In this step, your Mac restarts.

Step 8: Additional Software
In this step, you are prompted to insert the Mac OS X Disc 2 CD. When you do this, the
additional software you chose in Step 5 is installed. When this step is completed, your
Mac restarts, and you will set up your Mac with Setup Assistant.

Setup Assistant
After Mac OS X is installed, your Mac restarts and opens Setup Assistant. The first
screen you see is a welcome screen. During the setup process you are asked a number
of questions that will allow Setup Assistant to configure your computer and register
your software.

Network setup
You configure your network setup during this process, so make sure you have the 
network settings you recorded from Mac OS 9 available. In some cases (such as when
your computer is connected to a DHCP server), Setup Assistant can detect your network
and configure it for you, so you may not be asked any networking questions. If you are
unsure of your network settings, you can skip the network setup steps and configure
it later.

Setting up a user account
You also create your user account during the setup process. Make a note of your user
name and password for future reference. You can change your user account information
at any time after setup is complete.

Software Update
If your Mac is connected to the Internet, Software Update now opens and checks
whether any software updates are available from Apple. It’s recommended that 
you install any available updates right away, although you can run Software Update
again and do it at a later time. In some cases, you need to run Software Update more
than once to get all of the updates. This is because some updates can be installed 
only after previous updates are installed.

The installation is complete when Software Update reports that there are no new
updates available.

Installing the Classic environment 
If you’re working with a newer Mac that cannot start up in Mac OS 9, or one that can
start up in Mac OS 9 but shipped with Mac OS X, you can install Mac OS 9 (Classic)
from the Software Install and Restore disc that was included with your computer.

To install Mac OS 9:

1. Insert the Software Install and Restore disc.

2. Double-click the Install Applications & Mac OS 9 icon.

3. Follow the onscreen instructions.

If you need to quit the Installer before the installation is complete, choose Quit from
the Installer menu and click Restart, then hold down the mouse or trackpad button to
eject the Software Install and Restore disc. You may be able to eject the disc by press-
ing the eject button on a tray-loading optical drive or the Media Eject key on the key-
board. Your computer restarts using your current startup disk.
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Upgrading from a previous version 
of Mac OS X
If you are upgrading to Panther from a 
previous version of Mac OS X, you will see 
different installation options. Using the
Options button available in the disk selection
destination pane, you can choose either 
the “Archive and Install” option or the “Erase
and Install” option.

The Archive and Install option places the
existing system files in a folder called
Previous System, then installs a fresh copy 
of Mac OS X. With this option, you can retain
your user accounts, network settings, and
other user data just as it was before your
upgrade. Unlike the default installation,
third-party software or hardware support 
files in the System folder will be archived in 
a Previous System folder.

The Erase and Install option erases and 
reformats your disk using the selected disk
format, then installs the new version of Mac
OS X. With this option, all of your existing
data and settings are erased.



Note: If you determined that you still need some third-party extensions for Mac OS 9,
you can install them in the Classic environment at this point. If you are not sure
whether a particular extension will work in Classic, check with its developer. An 
example of an extension you might wish to install in Classic is Adobe Type Manager
Light. This extension allows your fonts to look good at all sizes and works well in
Classic. (ATM Light is available free from Adobe at www.adobe.com.)

Entering Your Recorded Settings
You now need to enter your recorded network and email settings on your new Mac
OS X system.

As mentioned earlier, if you are using DHCP to obtain an IP address for your Internet
connection, you should not need to enter your network settings manually. Mac OS X
should obtain all the information it needs when you run Setup Assistant. If you do
need to add or change any network settings manually, you can do so in the Network
pane in System Preferences.

Next, open your email program and enter the required setup information (user name,
hosts, and so on) in the appropriate locations.

Migrating Your Applications
As mentioned earlier, many Mac OS 9 applications have already been optimized for
Mac OS X. If you are using some applications that have not, they should run fine in the
Classic environment. Even if your older software runs on Mac OS X, you may want to
take this opportunity to upgrade to the latest version.

• Applications optimized for Mac OS X. After you install Mac OS X, you will find 
applications that have been optimized for Mac OS X, such as Adobe Photoshop 7,
in the Applications folder. The Applications folder is the default location for all 
Mac OS X–compatible applications.

• Classic applications. After you install Mac OS X, you will find your Mac OS 9–only 
applications in the “Applications (Mac OS 9)” folder. If you prefer, you can move Mac 
OS 9 applications to the main Mac OS X Applications folder. They will open as Classic
applications no matter which folder they’re in.

If your Mac is shared with other users and you want an application to be available
only to you, you can create a folder called Applications, or another descriptive name,
in your home directory (the directory, or folder, that has your name on it). You can also
create new folders to group applications according to your workflow needs. See the
section “Organizing Your Files” on page 29 for more suggestions on where to install
applications in Mac OS X.

Application preferences and data files
Whether you can move your preferences from Mac OS 9 to Mac OS X depends on the
application. Contact the developer of your application for information.

Data files created using an application in Mac OS 9 can almost always be opened with
a Mac OS X version of the application.
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Moving to a New Mac

Use this path if you will be moving your applications and files to a Mac that already
has Mac OS X. The Migration Checklist in Appendix I will aid you in completing the
necessary steps.

After you’ve completed the migration, familiarize yourself with Mac OS X by reading
the section called “Mac OS X Basics” and the subsequent sections on printing, fonts,
and other common tasks.

1. Evaluate your add-in cards and peripherals. (See “Evaluating Your Third-Party Hardware
and Peripherals,” page 19.)

2. Evaluate your applications. (See “Evaluating Your Software,” page 19.)

3. Record your current network settings. (See “Recording Your Mac OS 9 Network
Settings,” page 22.)

4. Record your current email settings. (See “Recording Your Mac OS 9 Email Settings,”
page 23.)

5. Enter your network and email settings. (See “Entering Your Recorded Settings,”
page 24.)

6. Install the Mac OS X and Mac OS 9 applications you need. (See “Migrating Your
Applications,” page 24.)

7. Copy your files from your old computer to the new one. (See “Moving Your Files 
to a New Mac,” page 25.) The section “Organizing Your Files” on page 29 has helpful
information on storing your files efficiently in Mac OS X.

18Guide for Creative Professionals
Migrating to Mac OS X



Evaluating Your Third-Party Hardware and Peripherals
Thousands of products from Canon, Nikon, HP, Sony, LaCie, Epson, Lexmark, 3M, Kodak,
Kensington, Logitech, and many other leading vendors are ready to work with Mac OS
X right out of the box. What external devices will you want to use with your computer?
These are the most common ones used in design and print work:

• Printers
• Scanners
• Removable storage devices
• Digital cameras
• Audio devices (microphones, speakers, other devices)
• Video cards
• CD burners
• PDAs
• SCSI add-in cards

Mac OS X features an advanced I/O system based on established open standards so
that it can support the entire spectrum of peripherals used by design professionals. It
comes configured with support for many camcorders, digital cameras, storage devices,
scanners, printers, and input devices. See Appendix B for links to up-to-date lists of
peripherals that are directly supported in Mac OS X.

Some products may require third-party drivers that have been adapted to take 
advantage of Mac OS X. Information on driver availability can be obtained directly
from the manufacturer or from the Apple downloads site at www.apple.com/
downloads/macosx/drivers.

Use checklist item 2 to record the information you find out from your hardware 
evaluation.

Evaluating Your Software
More than 10,000 applications specifically built for Mac OS X are already available 
and in use. This section helps you evaluate the software most often used by creative
professionals to determine whether you need to obtain upgrades or new versions 
of any of your current applications. You may also want to read the information at
www.apple.com/macosx/applications or check for other Mac OS X design and print
programs at guide.apple.com/design.

Types of Mac OS X applications
Most Macintosh developers have either created all-new Mac OS X applications or have
added Mac OS X compatibility to existing Mac OS 9 programs. Software written before
the release of Mac OS X can be run in the Classic environment of Mac OS X.

• Applications optimized for Mac OS X. To get the maximum benefits of Mac OS X,
you should use applications that have been designed to take full advantage of 
features in Mac OS X such as preemptive multitasking and automatic memory 
management. Some of the applications you are currently running in Mac OS 9 may 
fall into this category and should run perfectly in the Mac OS X environment.

• Classic applications. Other applications—those written before the release of Mac 
OS X—should run fine in the Classic environment of Mac OS X. You can install them
on your new Mac OS X system, then simply double-click one to launch Classic.

Even if your older software runs on Mac OS X, you may want to take this opportunity
to upgrade to the latest version. To find out whether your applications are optimized
for Mac OS X, you can try running them on a Mac OS X computer or check with the
application’s developer.
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Image editing and page assembly software
QuarkXPress, Adobe Photoshop, Adobe Illustrator, Adobe InDesign, Macromedia
FreeHand, and most other creative applications are now available in native Mac OS X
versions to help you work more productively than ever. Check with the developers 
of your applications to find out whether they have been upgraded. If not, you should
be able to use your Mac OS 9 versions in the Classic environment.

A number of popular third-party plug-ins and extensions that add features to Adobe
Acrobat, Adobe InDesign, QuarkXPress, and other applications have already been
updated to run on Mac OS X, and others are under development. Check with the 
vendors for their current status.

See checklist item 3 when you evaluate your image editing and page assembly software.

Font management software
If you have been using Mac OS 9 versions of professional font management applica-
tions such as Extensis Font Reserve, Extensis Suitcase, or Insider Software FontAgent
Pro, your transition will be easy, because the Mac OS X versions will be familiar to you.
In some cases, the software you’re already using on Mac OS 9 will also run on Mac OS
X. Check the system requirements on the software package or contact the vendor for
details. Note that Adobe Type Manager Deluxe is not available for Mac OS X. Please
see the “Extensions and control panels” section for more information.

Mac OS X includes a built-in application for managing fonts called Font Book. For more
information about Font Book, see Appendix G.

Use checklist item 4 to help you evaluate this category.

Internet applications
Mac OS X ships with a full-featured email application called Mail. Mail can import 
mailboxes from various email applications, including Entourage, Outlook Express, Claris
Emailer 2.0v3, Netscape 4, and Eudora, so switching to it is straightforward. In addition,
most third-party email applications have been updated to run natively in Mac OS X.
So if you prefer to keep using your current email program, it’s most likely available 
in a Mac OS X version. Check the vendor’s website for details. With the release of 
Mac OS X v10.3, Mail works with Microsoft Exchange mail servers, so you can access
your Exchange mail account from either a Windows or Macintosh computer.

Also included in Mac OS X is a fast, versatile, and innovative web browser called Safari.
You can import existing bookmarks from popular Mac OS 9 browsers into Safari, so
you may want to switch to Safari instead of upgrading your existing browser.

You can record the results of your Internet software analysis in checklist item 5.

Business applications
Microsoft Office v. X for Mac brings the new look and capabilities of Mac OS X to your
favorite Microsoft productivity applications. You can use your existing Word, Excel, and
other documents in this new version of Office.

Financial applications such as Quicken, QuickBooks, and MYOB are also available in
Mac OS X versions.

The SimpleText editor included with Mac OS 9 has been replaced in Mac OS X by the
more versatile TextEdit application.

Business applications are covered in checklist item 6.
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Importing bookmarks into Safari
The first time you open Safari, it automatically
imports bookmarks from Microsoft Internet
Explorer, Netscape Navigator, and Mozilla.

If you are using a web browser other than
those mentioned, you may be able to move
your bookmarks to Safari by exporting them
from your browser as an HTML document.
Then open the document in Safari and open
your Bookmarks Library in a separate window.
Drag the links from the first window to a 
collection in your Bookmarks Library.



Extensions and control panels
One of the advantages of Mac OS X is that you no longer have to worry about system
extensions and control panels conflicting with each other, because Mac OS X doesn’t
have them. If you desire specific functionality offered by any of your old extensions,
check whether Mac OS X has the equivalent feature built in. If it doesn’t, check with the
developers of your extensions to see whether they offer similar software for Mac OS X.

If you plan to use the Classic environment on your new Mac OS X system, you’ll want
to go through your Mac OS 9 extensions and control panels to determine which ones
you’ll need so that you can copy them to the new system when you migrate. Here 
are some of the extensions most often used by design and print professionals, with
information about whether you need to use them in Mac OS X:

Adobe Type Manager (ATM) and ATM Light are no longer needed because Mac OS X
has a built-in font rasterizer.

Adobe Type Manager Deluxe is not available for Mac OS X. There are several options
for this functionality. Mac OS X v10.3 has the built-in Font Book application, which
allows you to store all of your fonts in one tool and then build collections (sets) of
those fonts for various needs. There are also other font management applications with
more sophisticated features; see Appendix H for information.

Windows connectivity extensions are not necessary in Mac OS X because it has
built-in support for Windows and UNIX connectivity. Files from other operating systems
can be accessed from the Network icon in a Finder window or from the Go menu in
the Finder. When you access the network in this way, shared items automatically show
up in your Network browser. See Appendix H for information on third-party Mac and
Windows networking solutions.

File sharing on a Mac OS X client is simple and can be turned on in a single preference
pane. If you want more advanced sharing services, take a look at Mac OS X Server.
Third-party solutions are available for peer-to-peer file sharing; see Appendix H for
information.

Extensions managers are not needed in Mac OS X because it does not use extensions.

Use checklist item 7 to make sure that you’ve evaluated all of your extensions and
control panels.

AppleScript scripts
AppleScript is fully supported in Mac OS X. In fact, Mac OS X v10.3 ships with dozens
of useful preinstalled scripts. Using AppleScript Studio software, you can easily create
powerful Mac OS X applications written entirely in AppleScript that have the beautiful
Mac OS X interface.

Some of your existing AppleScript scripts may need to be modified to work properly
on Mac OS X, so you’ll want to test them once you’ve made the transition.

For more information, visit www.apple.com/applescript.

Checklist item 8 gives you a place to note that you’ve evaluated your AppleScript scripts.
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Recording Your Mac OS 9 Network Settings
If you’re planning to connect to a network or to the Internet through an ISP, you’ll
need to configure network settings in Mac OS X.

If you’ve been using DHCP to obtain a dynamic IP address on your Mac OS 9 system,
you will want to do the same in Mac OS X. To find out whether you’re currently using
DHCP, go to the TCP/IP control panel and check the settings for each configuration.

If you have a static IP address, use the instructions in this section to gather the network
configuration information from your current Mac so that you can set up networking
connections in Mac OS X.

Network information is stored in various locations in Mac OS 9 depending on the type
of network connection. In the TCP/IP and Remote Access control panels, you can
switch between configurations by choosing Configurations from the File menu. When
checking your settings, remember to record the settings for all of the configurations
you use—not just the active one.

TCP/IP. TCP/IP settings are stored in the TCP/IP control panel. You may have multiple
configurations that correspond to different locations in which you use your Mac, so be
sure to copy each one.
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PPP. The settings for PPP—used for dial-up connections—are located in the Remote
Access control panel. You may have multiple configurations, so be sure to copy 
each one.

PPPoE. Mac OS 9 doesn’t support PPPoE (PPP over Ethernet), so if you’re using this
connection method (such as with DSL), its settings are probably stored in a third-party
application provided by your ISP. Mac OS X has built-in support for PPPoE, so you will
not need a special application to use it after your transition. Check your ISP’s website
for instructions on setting up PPPoE in Mac OS X.

An easy way to copy your settings is to make a screen capture of the window in which
they are displayed. To do this in Mac OS 9, press Command–Shift–Caps Lock–4, then
click the window you want to record. The picture file appears on the top level of your
hard disk with the name Picture 1. Repeat as needed to capture your other settings
windows. You can open and print the pictures using SimpleText.

When moving your applications and files to a Mac that already has Mac OS X up and
running, you will need to go to the Network pane in System Preferences and enter your
network information in the TCP/IP, PPPoE, and/or AppleTalk sections.

You can record your network settings in item 9 of the checklist.

Recording Your Mac OS 9 Email Settings
To use your current email account with Mac OS X, you’ll need to copy some important
information about your account. That information includes your email address, password,
account type (POP or IMAP), user name, and the names of the incoming and outgoing
mail servers your account uses. If you can’t find this information, check with your
Internet service provider.

When you start up Mac OS X for the first time, the Setup Assistant application prompts
you for your email information. You can enter your settings then, or you can set up
your account later in Mac OS X Mail.

Locate your email settings by following these steps:

1. From the Mac OS 9 desktop, choose Control Panels from the Apple menu, then choose
Internet from the submenu that appears.

2. In the Internet window that appears, click the E-mail tab.
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3. Write down all of your information from the E-mail Account Information pane. Note
whether you are using a POP or IMAP account.

• Email address: yourname@provider.com
• Account ID or account name: yourname (example: jsmith)
• Password: yourpassword
• Incoming mail server (examples: pop.provider.net, mail.provider.com)
• Outgoing mail server (examples: smtp.provider.net, relay.provider.com)

Tip: You can print your email settings by taking a “snapshot” of your Internet window.
To do this in Mac OS 9, press Command–Shift–Caps Lock–4, then click the Internet
window. Open your hard disk, locate the newest picture file, and then double-click to
open it. When the picture opens, choose Print from the File menu. You can open and
print the pictures using SimpleText.

Use item 10 of the checklist to record your email settings.

Entering Your Recorded Settings
You now need to enter your recorded network and email settings on your new Mac
OS X system.

As mentioned earlier, if you are using DHCP to obtain an IP address for your Internet
connection, you should not need to enter your network settings manually. Open the
Network pane in System Preferences, click TCP/IP, and choose Using DHCP from the
Configure pop-up menu. If you need to use PPPoE, AppleTalk, and/or proxies, enter 
the appropriate settings in each of those panes. Then close the Network pane.

Next, open your email program and enter the required setup information (user name,
hosts, and so on) in the appropriate locations.

Migrating Your Applications
As mentioned earlier, many Mac OS 9 applications have already been optimized for
Mac OS X. If you are using some applications that have not, they should run fine in the
Classic environment. Even if your older software runs on Mac OS X, you may want to
take this opportunity to upgrade to the latest version.

• Applications optimized for Mac OS X. Once you move to your new Mac, you should
move applications that have been optimized for Mac OS X, such as Adobe Photoshop
7, to the Applications folder. This is the default location for all Mac OS X–compatible
applications. It is recommended that you reinstall them from the original program CDs
to ensure that all the files associated with each application are placed in the proper
folders.

• Classic applications. You should reinstall your Mac OS 9–only applications in the
“Applications (Mac OS 9)” folder. This is the default location for all Classic applications.
If you prefer, you can move Mac OS 9 applications to the main Mac OS X Applications
folder. They will open as Classic applications no matter which folder they’re in.

If your Mac is shared with other users and you want an application to be available
only to you, you can create a folder called Applications, or another descriptive name,
in your home directory (the directory, or folder, that has your name on it). You can also
create new folders to group applications according to your workflow needs. See the
section “Organizing Your Files” on page 29 for more suggestions on where to install
applications in Mac OS X.
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Application preferences and data files
Whether you can move your preferences from Mac OS 9 to Mac OS X depends on the
application. Contact the developer of your application for information.

Data files created using an application in Mac OS 9 can almost always be opened with
a Mac OS X version of the application.

Moving Your Files to a New Mac
When you transition to Mac OS X by moving to another Mac, you need to transfer
your files to your new computer. The examples in this section will guide you through
the process of moving files from a computer running Mac OS 9 to one running 
Mac OS X.

There are a number of ways to transfer your files from one Mac to another. The following
methods are discussed in this section:

• Use FireWire Target Disk Mode.
• Use an external FireWire hard disk drive.
• Copy files to a CD or DVD.
• Copy files over a network using a network cable or AirPort wireless networking.

Method 1: Copy files using FireWire Target Disk Mode
FireWire Target Disk Mode allows a Macintosh computer with a FireWire port to be
used as an external hard disk on another FireWire-equipped computer. The computer
acting as a hard disk is called the target. The computer accessing the target disk is
called the host. Once a target computer is started up as a FireWire hard disk and is
connected to the host computer, you can copy files to and from it.

Compatible systems
To use FireWire Target Disk Mode, both your Mac OS 9 computer and your Mac OS X
computer must have FireWire ports. In addition, the target computer must have:

• FireWire version 2.3.3 or later
• Mac OS 8.6 or later

All Mac systems with built-in FireWire ports can enter FireWire Target Disk Mode and
start up from FireWire, with the following exceptions:

• Power Mac G3 (Blue and White)
• Power Mac G4 with a 450MHz or slower processor and PCI graphics

The following models can be used for FireWire Target Disk Mode only if they have
received the firmware upgrade:

• Power Mac G4 with 500MHz or slower processor and AGP graphics
• Early FireWire-equipped iMac models (before July 2000)

You can test a Mac by restarting it and holding down the “T” key. If you see a FireWire
logo, Target Disk Mode is supported. If instead you see the normal Finder, either Target
Disk Mode is not supported on that system or the computer’s firmware is out of date.
You can find more information about models that support FireWire Target Disk Mode
and a link to firmware updates at docs.info.apple.com/article.html?artnum=58583.
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Using FireWire Target Disk Mode
You will use your Mac OS 9 computer as the target and your new computer as the
host. This allows you to browse your old files from your Mac OS X system. You can
then copy files from your old computer to your new one.

To use FireWire Target Disk Mode, follow these steps:

1. Make sure the target computer is turned off. If you are using a PowerBook or iBook as
the target, you should connect its power adapter to an AC source. The host computer
does not need to be turned off.

2. Connect the two computers with the appropriate FireWire cable. (Generally this is a 
6-pin-to-6-pin cable, although if your new computer has FireWire 800, you can also
use a 6-pin-to-9-pin cable. Be aware, however, that the transfer speed will be that of
FireWire 400, the speed of FireWire on your Mac OS 9 system.)

3. Start up the target computer. Immediately press and hold the “T” key until the FireWire
icon appears. The hard disk of the target computer should appear on the desktop of
the host computer (unless your Mac OS X system preferences are set not to display
connected volumes, in which case you’ll need to navigate to the target drive from a
Finder window).

4. Now you can begin copying files. When you are finished, drag the target computer’s
hard disk icon to the Trash or choose Eject from the File menu.

5. Turn off the target computer and unplug the FireWire cable.

Method 2: Copy files using an external storage device
If you are unable to use FireWire Target Disk Mode, you can use an external storage
device to transfer your files.

External storage devices come in many shapes and sizes. There are hard disk drives,
solid-state devices that can fit on a keychain, and removable media devices (such as
Iomega’s Zip drive). All of these devices commonly connect to your Mac using either
FireWire or USB. A FireWire connection usually provides faster throughput than a USB
connection, so if you have a choice, use FireWire.

If your device has a small storage capacity, you may have to make multiple trips
between your two computers. To use this method, you must make sure you don’t 
have a file that is larger than the capacity of your external device.

Unless your external device can plug directly into the computer’s FireWire or USB 
port (typically the case with keychain units), you will need a cable. See the sidebar 
for information about FireWire and USB cables.

Although it’s unlikely, you may need software that allows your external device to work
with your Mac systems. Check with the maker of the device to see whether you need
to do anything special to make it work.
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FireWire and USB cables
FireWire connectors come in three varieties:
9-pin, 6-pin, and 4-pin. All current Macintosh
computers have FireWire 400 ports that use
6-pin connectors. Some Macintosh models
also have FireWire 800 ports, which use 9-pin
connectors. You will need to determine
which kind of connector your external storage
device uses. Various types of FireWire cables
are available to go between two similar or
dissimilar connectors.

USB connectors come in two varieties:
Type A and Type B. Computers use Type 
A connectors, and according to the USB 
specifications, external devices should use
Type B connectors, so all you should need is
a standard USB A-B cable. However, some
external devices use Type A connectors, so
be sure to check before buying a cable.



Once you have confirmed that your external storage device works with both computers,
you can start transferring files. Follow these simple steps:

1. Connect your external storage device to your Mac OS 9 computer.

2. Copy some files from your Mac to the storage device.

3. Disconnect the device.

4. Connect the device to your Mac OS X computer.

5. Copy the files from the device to your Mac OS X computer.

6. Remove the copied files from the device.

7. Remove the device from your Mac OS X computer and repeat steps 1 through 6 until
all of your files have been transferred.

Method 3: Transfer files via CD or DVD
If you cannot use either of the preceding methods and you have a CD or DVD recorder
on your Mac OS 9 computer, you can use it to make one or more discs containing your
data files. Once you’ve copied all of your files onto a disc, simply insert it into your new
Mac and copy the files to the hard drive.

Method 4: Copy files over a network
One of the easiest ways to connect two Macintosh computers together is to network
them. You can connect them to an existing Ethernet network, run an Ethernet cable
from one to the other, or use Apple’s AirPort wireless networking. Once you have the
systems networked, use the steps on the following pages to copy your files.

If you use a direct Ethernet connection, you need a standard RJ-45 Cat-5 Ethernet
cable. All recent Macintosh models automatically configure themselves to work with
either a crossover cable or a standard Ethernet cable. Older models require a crossover
cable. To find out the cabling requirements for your Mac, see docs.info.apple.com/
article.html?artnum=42717.

Step 1: In Mac OS 9—Turn on AppleTalk
1. From the Apple menu, choose Control Panels > AppleTalk.

2. Select Ethernet from the “Connect via” pop-up menu.

3. Quit the control panel.
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Mac OS 9 file sharing
It’s easy to share files from a Mac running
Mac OS 9 with those running Mac OS X. In
the File Sharing control panel of the Mac 
OS 9 system, go to the Start/Stop tab. Make 
sure that file sharing is turned on and that
“Enable File Sharing clients to connect over
TCP/IP” is selected.

If you are using static IP addresses and both
computers are connected to the Internet,
you need to make sure that each computer
has a different address. Even if you plan to
use your old static address on your new Mac
after your transition, during the time you’re
transferring files, the two computers must
have different addresses. This problem can 
be avoided by disconnecting the computers
from the Internet, using DHCP instead of static
addresses, or temporarily obtaining a static
address for the Mac OS X system that’s differ-
ent from that of the Mac OS 9 computer.

For more information about Mac OS 9 
file sharing, see docs.info.apple.com/
article.html?artnum=107369.



Step 2: In Mac OS 9—Turn on File Sharing
1. From the Apple menu, choose Control Panels > File Sharing.

2. Select the Start/Stop tab.

3. Enter an owner name in the Owner Name text field if one isn’t already present. Make 
a note of the owner name—you’ll need to enter it in order to connect to your Mac
across the network.

4. If you don’t know your current password, enter a new password in the Owner
Password text field. Make a note of the password; you’ll need to enter it in order to
connect to your Mac across the network.

5. Enter a name for your computer if one isn’t already present. This is the name that
identifies the computer when you browse the network for it.

6. In the File Sharing section, select “Enable File Sharing clients to connect over TCP/IP,”
then click Start.

7. Quit the control panel.

Step 3: In Mac OS X—Copy your files
1. Click the Network icon in any Finder window. Your Mac OS 9 computer’s name and

icon should appear in the Finder window. If it doesn’t appear, make sure you have
properly completed the previous steps.

2. Double-click your Mac OS 9 computer’s icon. The Name and Password dialog appears.

3. Enter the owner name and password you defined in Step 2 into the appropriate text
fields, then click Connect. If you entered the name and password correctly, you see 
the list of volumes connected to your Mac OS 9 computer.

4. You can now navigate around your Mac OS 9 volumes and copy files to your 
Mac OS X system.

5. When you are done copying your files, you can disconnect from your Mac OS 9 
system: Go to the Finder and highlight the Mac OS 9 volume’s icon by clicking it.
Then choose Eject from the File menu (or type Command-E).

6. Once you have disconnected, you can shut down the Mac OS 9 computer or remove 
it from the network.
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Mac OS X Basics

Welcome to Mac OS X! Users familiar with Mac OS 9 will feel right at home here. You’ll
find favorite features as well as exciting new ones. Here’s a summary of how Mac OS X
operates, including some ways in which it differs from Mac OS 9.

You can see a handy guide to Mac OS X at www.apple.com/macosx/learning.

Organizing Your Files
Mac OS X is a multiuser operating system, so it can keep the documents and prefer-
ences of a computer’s users separated and properly arranged. This means that two
people can use the same computer and have a different experience. It also means that
the directory structure of Mac OS X is different from that of Mac OS 9.

In addition, you will encounter a number of seemingly duplicate folders throughout
the file system. These folders each serve a different purpose and are a necessary part
of a multiuser operating system. After reading this section, you’ll be familiar with the
Mac OS X file structure. You’ll want a basic understanding of that structure before you
copy your files to a new Mac OS X system so that you can make informed decisions
about the best place to put each file.

User-specific folders
User-specific folders are those that are available only to a single user of the system.
Each time a user is added to the computer, Mac OS X creates a new folder named after
that user. This folder is called a home directory, and it contains all of the user’s files
and preferences. When a user logs in to the system, Mac OS X makes his or her home
directory active and uses the information in it to set up the user’s desktop environment.

These home directories are stored in the Users folder at the root (top) level of the
startup volume. You can quickly navigate to your home directory in a number of ways:

• In any Finder window, click the house icon in the lefthand column.
• In the Finder, choose Home from the Go menu.
• In the Finder, press Shift-Command-H.

In a multiuser environment, security is important. All but two of the folders in your
home directory are locked to other users of the system. As long as you use the proper
folders, all of the files you save will be accessible only to you.
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Folders and directories
Macintosh users are accustomed to the 
term “folder” in discussions of the computer’s
file system. In the Mac OS X world, you 
may also see the term “directory.” The terms
are interchangeable, and this document 
uses both.

Permissions
Because Mac OS X is a multiuser system,
different users have different “permissions,”
or privileges, to access files and folders on 
an item-by-item basis.

You can see the permissions for an item 
in the Finder by selecting it and choosing 
Get Info from the File menu. In the Info 
window, click the disclosure triangle next to
Ownership & Permissions to view the settings
for the item. If you are the owner of the item
or an administrator, you may also be able to
change the item’s permissions.



Home directory folders
You will notice that your home directory contains a number of folders with special
icons. These folders are used by many applications as default locations for saving files.
Each folder’s name describes the types of files it is designed to store. You can actually
store any type of file in any of the folders; their names are just a convenient way to
help keep your files organized.

Here are some of the folders you’ll see in your home directory when you first use 
Mac OS X. You can also make new folders as your needs dictate.

• Desktop. This folder contains the contents of all the files and folders currently 
displayed on your desktop. If you place this folder in your Dock, you can view the 
contents of your desktop without closing your application windows—especially 
handy if you have a lot of files on the desktop. When you view the desktop from 
the Dock, you have access to all Mac OS X folder views, including “View as List.”

• Documents. This is a place to store files such as letters, financial documents, spread-
sheets, and so on. You may notice that some applications also store files here.

• Library. This folder holds your application preferences, resources, sounds, and 
other files needed by applications and the system to create your individual desktop
experience. For example, your browser bookmarks are kept here. Each user of the 
system shares the same browser application, but the bookmarks that the browser 
uses are taken from the logged-in user’s Library folder.

• Movies. Use this folder to store your movie files. If you need to find a movie, simply
navigate to your home directory and open your Movies folder. This is the default 
location that iMovie uses to store your movies.

• Music. Use this folder to store your music files. If you need to find a song, navigate to
your home directory and open your Music folder. This is the default location that
iTunes uses to store your music.

• Pictures. Use this folder to store your digital pictures. This is the default location that
iPhoto uses to store your photos.

• Public. This folder is also available to other users of the system. If you enable Personal
File Sharing, files placed in this folder are available to everyone, so don’t store sensitive
information here. In the Public folder is a folder called Drop Box. Other users can put
files into the Drop Box, but they can’t open it. As the owner of your Drop Box, you can
open it to retrieve its contents. This is a way for other users to give you files that are
intended only for you to view.

• Sites. This folder is open to all users and is used if you want to host a web page on
your system. Don’t store sensitive information in this folder.

You may notice a folder called Shared at the same level as the individual users’ folders.
This folder is used by applications to store preferences needed by all users. You can
also use the Shared folder for files that you want to share with all users of the system.
Unlike your Public folder, which by default makes files available on a read-only basis,
files in the Shared folder have full read/write access. You can decide which folder to
use for each shared file depending on what kind of access you want it to have.

Users in professional environments often want to customize the folder structure on
their workstation. This is done for a variety of reasons. Some people want to make it
easier to know what came installed on the Mac and what they installed. Others want
to keep information organized by usage, such as having all drawing applications in
one subdirectory or folder. Whatever your needs or reasons, it is possible to organize
your custom applications in folders other than those provided by the initial installation
of Mac OS X. It is recommended, however, that you do not remove or relocate the
base applications that Mac OS X installs on the system.
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Why are there two Desktop folders?
When you start up Mac OS X for the first 
time on a Mac that has previously started 
up in Mac OS 9, you may find two Desktop
folders. One is in your home directory and 
is simply called “Desktop.” The other one, at
the computer (root) level, is called “Desktop
(Mac OS 9).”

If you’re like many users, you prefer to keep
certain files and folders on your desktop.
Because Mac OS 9 is essentially a single-user
system, it typically has only one desktop area.
However, Mac OS X allows each user to have
an individual desktop. That’s why you’ll see a
Desktop folder in each user’s home directory.
But when Mac OS X starts up and finds items
that were on the Mac OS 9 desktop (where
the concept of multiple users is unknown),
it can’t assign those items to a specific user,
so it puts them at the root level, above the
user directories.

To see the files that were originally on your
Mac OS 9 desktop, simply open the folder
named “Desktop (Mac OS 9).” If there were 
no files on the Mac OS 9 desktop when you
started up the computer in Mac OS X, that
folder will not be present.

Note that if you installed Mac OS X on a 
separate partition from Mac OS 9, your Mac
OS 9 desktop files are in a folder named
“Desktop Folder” at the root level of the 
partition in which Mac OS 9 is installed.



If you want to keep data on your computer that only you have access to, and have the
folder title be meaningful to your workflow, you can create custom folders with any
name you like, such as My Projects. Or you may want to create an Applications folder
to hold applications that only you use. (Note that some applications look for a folder
named Applications in which to store files, so if you want to avoid that, you should call
your folder something like My Applications.)

The access privileges for user-created folders depend on the folder’s location. Any 
folder or file that you put in the root level of your home directory is available to all
users. If you want a folder or file to be available only to you, put it in one of the 
folders that is locked to other users.

System-level folders
At the root level of the startup disk are a number of folders used by Mac OS X to 
configure the operating system itself. Among the most important folders are:

• Applications. This folder is the default location for storing applications that need to be
available to all users. It therefore has read and write access for users. Most application
installer programs use this folder as the default location for storing the application. You
can quickly navigate to the Applications folder in a number of ways:
– In any Finder window, click the Applications icon in the lefthand column.
– In the Finder, choose Applications from the Go menu.
– In the Finder, press Shift-Command-A.

• System. This folder contains important files that are critical to the operation of the
system. Regular users are restricted to read-only access to the files in this folder.
You will need administrator privileges to make changes to this folder. Do not make
changes to it unless you fully understand their ramifications.

• Library. This folder is used to store system configuration files and application 
preferences that affect all users of the system. You must have administrator privileges
to make changes in this folder.

• Users. This folder contains the home directories of all users of the system.

Note that if you have installed the Classic environment, the startup disk also has a
folder called System Folder. This folder contains the Mac OS 9 operating system and 
all Mac OS 9 system-level files, such as fonts and control panels.

Filenames and extensions
Macintosh systems have never required filename extensions to associate a document
with the application that created it. Behind the scenes, the Mac OS has used hidden
attributes (called file types and creators) to keep track of the type of a document
(JPEG or TIFF image, PDF file, Microsoft Word document, Excel spreadsheet, and so on)
and the application that should be started when the document is double-clicked.

While this approach has been ideal for Macintosh users, it has sometimes led to 
compatibility problems when documents are sent to users of Microsoft Windows 
computers, because Windows requires filename extensions to keep track of document
types. Windows “dot extensions” consist of three letters preceded by a period. Common
examples of Windows filename extensions for nonexecutable files include .doc for
Microsoft Word documents, .pdf for PDF files, and .xls for Microsoft Excel files.

Mac OS X preserves the ideal Mac experience while ensuring full filename compatibility
with Windows applications. Mac OS X v10.3 “Panther” automatically adds the proper
extension to the filename of any document that is saved in a Mac OS X application.
But by default, the extension is not displayed in the Finder or in Open and Save dialogs
(unless the person who saved the file explicitly typed the extension in the filename).
Yet the filename does have the proper extension, so no renaming or translating is
needed when the file is used on a Windows-based system.
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Why are there multiple Library folders?
You might be wondering why there is more
than one Library folder. If you’ve looked
inside the various folders, you’ve noticed that
each one has similar contents. There are a
number of Library folders because Mac OS X
is a multiuser operating system. Having 
multiple folders allows the system adminis-
trator to decide which users should have
access to which Library elements.

For example, each Library folder contains 
a Fonts folder. Which applications and users
can use specific fonts depends on which
/Library/Fonts folder the fonts are put in.
(See “Where to Install Fonts” on page 55 for
details.) The same is true of Preferences,
Printers, Keyboard Layouts, and other folders
that reside in every Library folder.

The libraries and their contents are hierar-
chical; the settings of the lower-level folders 
can override or supplement the settings in
the higher-level folders. So anything you
have in your individual Library folder takes
precedence over the Library folder in the
System folder, and anything in that folder
takes precedence over the Library folder at
the top level of the startup drive.



If you wish, you can change your Finder preferences to display these hidden filename
extensions. Mac OS X can differentiate between files called, for example, “filename”
and “filename.doc,” so having extensions displayed ensures that you know the exact
name of each file. That setting is therefore recommended for professional publishing
environments, because it can prevent problems with workflow scripts and version 
control caused by filename confusion. If you do not want to turn on extension display
globally, you can view the extension of a specific document in the Name & Extension
field of the document’s Info window.

Even though Mac OS X can automatically append file extensions, some applications
do not take advantage of this feature. When you’re saving files, it’s always a good 
practice to check the “Append file extensions” box if one is available in the Save dialog.

Memory Management and Allocation
In Mac OS X, you no longer need to allocate memory to each application. The operating
system handles all memory management and virtual memory, which is always in use.
You will still need to allocate memory for any Classic applications you use, just as you
did in Mac OS 9.

System Preferences
You can now manage a wide range of system customization options in a single program
called System Preferences. It’s located in the Applications folder on your Mac OS X disk,
or you can easily access it at any time from the Apple menu. Third-party utilities and
drivers can add their own preference panes to System Preferences, providing one central
location for managing your preferences.
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The Dock
Located by default at the bottom of the screen, the Dock gives you instant access to
the programs, files, and tools you use most. All open applications are represented by
Dock icons. To put your own often-used items within easy reach, simply drag them to
the Dock. Similarly, you can remove an item by dragging it out of the Dock. Items you
may find useful to add to the Dock include your Desktop folder, Printer Setup Utility,
and any application or document folders you use frequently.

As you add items, the Dock expands until it reaches the edges of the screen—at which
point the icons shrink to accommodate more items. You can change the size of the
Dock at any time from System Preferences. Or you can change the size by dragging
the line that divides the Dock.

To make reduced-size icons in the Dock more easily recognizable, Mac OS X includes 
a magnification option. When you pass your cursor over the icons, they magnify to the
level you have set in Dock preferences. You can also make the Dock hide itself when
you’re not using it. Minimized windows (ones that you’re not currently using but want
to keep handy for easy access) display a miniature view of the full window. You can
make the windows active again with a single click.

The Dock gives you quick access to useful functions. You can use its contextual pop-
up menus to quit any application or to navigate to any open window of a selected
application. If you’ve stored a folder in the Dock, clicking and holding its icon allows
you to view the files and folders within it. Clicking and holding the Trash icon allows
you to empty the Trash, if there is anything in it.

If you prefer, you can place the Dock at the right or left side of the screen instead of the
bottom. Dock preferences can be changed by selecting Dock from the Apple menu.
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Finder Windows
Every Finder window can display a toolbar along the top that gives you instant access
to various functions. For example, you can move up and down directory levels, switch
to a different view, add a color label, and so on. You can turn the display of the toolbar
on and off by clicking the button in the upper-right corner of any Finder window, or
by selecting Hide Toolbar/Show Toolbar from the View menu. You can customize the
toolbar by selecting View > Customize Toolbar.

There’s a handy column on the left side of Finder windows that displays available disks
and servers. You can also use this sidebar to store important applications, folders, and
documents.
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The column view—a new feature in Mac OS X—lets you see your files in context.
The rightmost column can even give you a preview of many common file types. For
example, you can watch a QuickTime movie, hear a song, or view a still image—all
without launching an application or opening the file. You can change the width of the
columns by dragging the bottom of the column dividers. This is the same view that
you see in the Mac OS X Open and Save dialogs.

When you use column view for the first time, it may be easiest to start by moving the
slider to the far left and then navigating to the right to find the folder you want. This
method will quickly get you oriented to this powerful new navigation system.

Application Menu
Unlike earlier versions of the Mac OS, each Mac OS X application has an application
menu. It has the name of the application, and it appears between the Apple menu
and the File menu. The application menu contains several items related to the applica-
tion itself, including the About box, program preferences, relevant Mac OS X services,
options to hide or show windows from this and other applications, a Quit command,
and other options determined by the application’s developer.
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Exposé
Powered by the Mac OS X Quartz graphics engine, Exposé is a major advance in user
interface design that will change the way you work with multiple files, applications,
and projects. Exposé gives you instant access to any open window with a single key-
stroke. You can display all windows as thumbnails, view windows only of the current
application, or hide all windows to quickly locate a file on your desktop.

There are three Exposé modes:

Instantly switch to any open window. Instead of moving, resizing, hiding, and mini-
mizing many windows just to find the one you need (and then putting them all back
after finding it), Exposé lets you get to any window instantly. It scales down all of your
open windows and arranges them onscreen so you can see all of them at the same
time. Each window retains its contents and proportions, making it easy to identify.
Simply move the cursor over any window and click (or deactivate Exposé) to activate
the window and return all windows to their normal size and position.

Instantly switch to any window in the current application. When you are working
on several documents in a single application, Exposé lets you focus on just those 
windows, instead of every window on your Mac. Rather than displaying all windows,
Exposé can show you just the windows of the current application.
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Instantly access the files and folders on your desktop. When you download files
from the web or save email attachments to the desktop, their icons are often obscured
by windows. With Exposé, you can get to your desktop files and folders instantly,
without disturbing the careful setup of your windows. Exposé temporarily moves all 
of your windows to the edges of the screen, leaving just your desktop. You can start
dragging any desktop icon, and then deactivate Exposé to bring back all your windows.
You can then drop the selection onto any window of your choosing.

It’s easy to use Exposé:

• To see all your open windows, hold down the F9 key.

• To see all the windows open in your current application, hold down the F10 key.

• To hide all the open windows so you can see the desktop, hold down the F11 key.

When you press and hold the keys to activate Exposé, the windows return to normal
as soon as you release the keys. If you press the activation keys quickly instead of
holding them, Exposé stays activated until you press the key again.

You can use System Preferences to modify how you use Exposé:

• Screen corners. You can activate Exposé simply by moving your mouse to a corner of
the screen. You can decide which screen corners activate which Exposé views.

• Function and modifier keys. You can set function keys and unused modifier keys to
activate Exposé.

• Multibutton mouse. You can assign the different Exposé views to the buttons of a
multibutton mouse.
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Open and Save Dialogs
In Mac OS X, Open and Save dialogs look almost identical to Finder windows.

The Save dialog may open in a collapsed view that shows only a pop-up menu 
containing locations to save files—including the items in the lefthand column of 
your Finder windows and locations you have recently used—and a place to enter 
the name of the file to be saved.

If you want to save the file in one of these locations, simply select it in the pop-up
menu and enter the desired filename. However, if you want to navigate to some 
other folder location on your system or network to save the file, you can click the
downward-pointing arrow next to the filename to expand the window and display 
the column view browser, allowing you to navigate to the desired folder. Once you
have selected a folder, it is added to your Recent Places list.
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When you use a Mac OS X Open or Save dialog for the first time, it may be easiest 
to start by moving the slider to the far left and then navigating to the right to find 
the folder you want. This method will quickly get you oriented to this powerful new
navigation system.

Connecting to a Server
Mac OS X allows you to connect to every major file server protocol on every major
platform in use today. This includes Apple, UNIX, Linux, Novell NetWare, and Windows
computers and servers. In Mac OS X, connecting to other computers and servers is 
no longer done through the Chooser as in Mac OS 9. You can browse the Network
view in the Finder or you can use the Connect To Server dialog.

Network view
The Network view shows any server that is browsable on your local network. It lists
the servers by name and lets you select the one you want without having to type 
an address. Simply click Connect and complete the connection dialog. This method 
is most useful when you don’t know the server’s address or you simply want to see
everything that is browsable on the network.
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Connect To Server dialog
To use Connect To Server, you must first know the server’s address—that is, its name or
IP number. You can get that information from the person who administers the server.

1. From the Go menu, choose “Connect to Server.”

2. Type the server’s address, click Connect, and complete the connection dialog. (Note
that clicking Browse takes you back to the Network view.) The address should be 
prefaced by the protocol with which you are connecting, such as afp:// or smb://. For
example, a complete address might be “afp://fontserver1” or “smb://192.168.0.2.” When
you do not specify the protocol, the Connect To Server dialog assumes that you want
an Apple File Protocol (AFP) connection.

You can also use Connect To Server to connect to local servers if you prefer it to
browsing the Network view. For convenience, the Connect To Server dialog contains a
Recent Servers list and a place to list your favorite servers.

For more information on server connectivity in Mac OS X, see the article “Mac OS X
10.3: About Network Browsing and Connected Servers” at docs.info.apple.com/
article.html?artnum=107804.

Force-Quitting an Application
Because of protected memory in Mac OS X, an application that misbehaves does 
not harm the overall system. If an application becomes unresponsive, you may 
need to “force-quit” it. As in Mac OS 9, you can force-quit an application by pressing
the key combination Command-Option-Escape. Unlike Mac OS 9, which force-quits 
the frontmost application, Mac OS X opens a window that lists the currently running
applications and allows you to choose one or more to force-quit. Note that this 
list includes the Finder. Because the Mac OS X Finder is an application much like 
any other, it can be quit and relaunched from this window without affecting other
running applications.
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Linking a Document Type to an Application
You may have more than one application that can open a particular type of file. For
example, TIFF documents (.tif ) open by default in Apple’s Preview application. If you
have Adobe Photoshop, you may want to have it open these files instead.

Using TIFF files as an example, do the following:

1. In the Finder, select a file that has the .tif filename extension.

2. Choose Get Info from the File menu.

3. In the Info window, click the “Open with” disclosure triangle.

4. In the pop-up menu, select the application that you want this file to be opened
with—in this example, Adobe Photoshop.

5. If you want all files with this extension to be opened in Photoshop, click Change All.

6. When the confirmation dialog appears, click Continue.

7. Close the Info window.
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The Classic Environment
The Classic environment in Mac OS X enables you to run Mac OS 9 applications that
have not been upgraded to run in Mac OS X. You can start the Classic environment
from the Classic pane in System Preferences or by double-clicking any Classic (Mac 
OS 9) application. You can also stop, restart, or force-quit Classic from the Classic pane.

Using the Classic system preference
You can control the behavior of the Classic environment using the Classic pane in
System Preferences. The three panes in this preference let you set up and monitor 
the behavior of the Classic environment.

Use the Start/Stop pane to:

• Set which Mac OS 9 System Folder to use for Classic (in case you have multiple Mac
OS 9 systems installed on your Mac).

• Start, stop, restart, or force-quit Classic.

• Have Classic start automatically when you log in. This is useful if you often use Classic
applications.

• Have Mac OS X warn you before Classic is started. If you double-click a Classic applica-
tion to open it, you will be given the chance to stop the process before Classic is started.

Use the Advanced pane to adjust the advanced settings and to troubleshoot the
Classic environment. From this pane you can start Classic in special ways, similar to
Mac OS 9 itself. The advanced settings include:

• Use Mac OS 9 preferences from your home. This function is useful if there are 
multiple users of the system. With this option checked, when users start Classic the
first time, a dialog lets them copy existing preferences from the Mac OS 9 System
Folder to the Classic folder in their home Library folder.

• Put Classic to sleep when it is inactive. If the Classic environment is running but you
don’t have any Mac OS 9 applications open, this option allows Classic to go to sleep 
to reduce its use of your computer. Use this setting to specify how long Classic waits
to go to sleep after you quit the last Classic application. If Classic is in sleep, opening a
Mac OS 9 application may take a little longer.

• Rebuild Desktop. This command rebuilds the Classic desktop file of icons and docu-
ment-application bindings for the selected startup volume.

The advanced settings that aid in troubleshooting are in the pop-up menu next to 
the Restart Classic button. These options are:

• Turn Off Extensions. Because extensions can sometimes cause unexpected behavior
in Mac OS 9, it’s useful to be able to launch Mac OS 9 without extensions when trou-
bleshooting problems.

• Open Extensions Manager. This option allows you to activate or deactivate specific
extensions, rather than simply turning them all off. If you have Conflict Catcher
installed in Classic, the system will restart in it instead of in Extensions Manager.

• Use Key Combination. This option allows you to define keystrokes that start or restart
the Classic environment.

The final pane, Memory/Versions, allows you to view the memory usage of applications
running in Classic. This is similar to the information you would find in the “About this
Computer” dialog under the Apple menu in Mac OS 9.
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Printing in Classic
If you plan to print from applications running
in Classic, you need to make sure that the
appropriate printer drivers are available to
the Classic environment.

If you are using a non-PostScript printer,
you will have to install its printer driver in
Classic. If you configure a PostScript printer
using Printer Setup Utility, the printer will 
be available for Classic applications, but if 
you wish to use Mac OS 9 PostScript drivers,
they also need to be reinstalled in Classic.
Here are the ways you can do that:

• Download and run the most recent printer
driver installer from your printer manufactur-
er’s website.

• Run the installer that shipped with your
printer. Keep in mind that this may not be
the most current version of the printer driver.

• If you are unable to locate an installer for
your printer and the printer was used on 
your Mac OS 9 system, you can copy the
existing driver into Classic. In Mac OS 9, printer
drivers are stored in the System Folder:
Extensions folder. If you are using a PostScript
printer, you will find its PPD file (PostScript
Printer Description file) in the System Folder:
Extensions: Printer Descriptions folder. Simply
copy the files from your old system to the
same locations in Classic.



Printing

The printing system in Mac OS X v10.3 “Panther” takes advantage of open standards
and open source software, enabling you to produce professional-quality output on a
wide range of devices with ease, effortlessly save color-managed PDF files right from
the Print dialog, and efficiently share both networked and directly connected printers
in a mixed computing environment.

In Mac OS X, all printers are always available from any application. You can switch 
from printer to printer instantly to meet the needs of each job, without having to
open and reconfigure the Chooser. The Printer Setup Utility application, which replaces
the Chooser, provides fast access to many different printing-related commands and 
settings. New support for multithreaded printing allows developers to write their
applications so that you can send a job to one printer and immediately print again 
to another type of printer. The system automatically sends each job to the correct
device. Also, even printers that aren’t network enabled can be made available to all
users on the network at no additional cost.

Supported Printing Protocols
The following printing protocols are supported in Mac OS X:

• AppleTalk. Many AppleTalk printers are still in use in creative environments because
they are easy to set up, support the printing of binary data, and offer back-channel
(status) communication.

• IP printing. The Internet Printing Protocol (IPP) and the LPR/LPD protocol enable
printing to a wide array of printers and print servers across subnets. While both 
protocols generally print faster than AppleTalk, they differ from each other (and from
AppleTalk) in the amount of back-channel communication. To receive status notifica-
tions (such as printer error messages) when printing over a network, you should
choose either AppleTalk or IPP printing if one of those protocols is supported by your
printer; check with the manufacturer. Otherwise, choose LPR/LPD.

• Bluetooth printing. If you have a Bluetooth-enabled Macintosh with Mac OS X v10.3.2
or later, the Bluetooth 1.5 update adds the ability to print to supported Bluetooth
printers.

• Windows printing. Mac OS X v10.3 supports the native Windows printing protocol
(SMB) for peer-to-peer printing or sending files to a managed print server on the 
network. This support allows you to extend the use of your direct-connect printers to
Windows users on your local network. Conversely, it also enables Mac users to access 
a Windows shared printer. To share a printer with Windows users via SMB, use the
Sharing pane in System Preferences to enable Printer Sharing, then enable Windows
Sharing. This shares all queues. (It is not possible to share individual queues.) Files
printed from a Windows system to a Mac use PostScript.
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For more details on sharing your printers with Windows users, see the following 
documents:

– “Windows Compatibility and Mac OS X Technology Brief”
(available at www.apple.com/macosx/features/windows) 

– “Setting Up to Print to a Printer Shared by a Windows Computer”
(docs.info.apple.com/article.html?artnum=32329)

– “Sharing Your Printer with Windows Users via SMB”
(docs.info.apple.com/article.html?artnum=32315)

– “What Do I Use Instead of the Printing Control Panel?”
(docs.info.apple.com/article.html?artnum=125025)

Supported Printing Interfaces
In addition to using Ethernet, many printers can be connected directly to your 
computer via the USB or FireWire port. With a printer set up, you can turn on Printer
Sharing in the Sharing pane of System Preferences to allow other computers on 
your network to use your directly attached printer.

Supported Printers
Mac OS X Panther includes drivers to support hundreds of printers from vendors such
as Brother, Canon, Epson, HP, Lexmark, and Xerox. Mac OS X printing is based on the
Common UNIX Printing System (CUPS). The wide range of available CUPS-compliant
print drivers means that you may be able to use a printer even if the manufacturer has
not provided Mac OS X support.

Panther also comes with the Gimp-Print open source printer driver project, which 
supports hundreds of printers. That means you can probably use your printer without
having to install any software. In many cases, Panther even creates a queue for you, so
no setup is required. You can check the Mac OS X section of the Gimp-Print website 
at gimp-print.sourceforge.net/MacOSX.php3 for new and updated drivers compatible
with CUPS and your printer. Currently more than 500 printer models are supported
through Gimp-Print; new ones are always being developed and older ones improved.

For a list of printers and other external devices that are compatible with Mac OS X, see
www.apple.com/macosx/upgrade/devices.html.

PPD Files
A PPD (PostScript Printer Description) file is simply a text file that contains information
about a specific model of PostScript printer—the printer’s available page sizes,
halftone screening settings, output resolution, and the like. The PPD file is used by the
system to populate the various controls you set in the Page Setup and Print dialogs.

If you use a PostScript printer, you will need a PPD file for it. If the printer shipped with
a print driver installer, that application should install the necessary PPD automatically.
However, if you work in the design and print industry, you may need to generate and
send PostScript files to printing companies. To do this, you will have to manually install
a PPD file for the printer that the printing company will use for the job. When you
install PPD files manually, be sure to put them in the appropriate lproj folder for the
language you are using on the Mac (see the next section for details).
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Rendezvous
The Rendezvous technology built into Mac
OS X v10.3 allows computers and other 
smart devices to create a network instantly
by finding and connecting to each other
automatically. With Rendezvous, each device
broadcasts which services (such as file 
sharing or printing) it’s offering for the use 
of others, and discovers the services provided
by the other devices. For example, two 
colleagues in a meeting can establish a net-
work to share files simply by turning on 
their AirPort-enabled PowerBook systems and
letting Rendezvous connect them. When a
Rendezvous-enabled computer is connected
to a wired network, it automatically discovers
and lists available Rendezvous-enabled 
printers.

Rendezvous uses standard protocols such 
as IP, ARP, and DNS and works with today’s
most popular connection technologies,
including Ethernet, AirPort, and AirPort
Extreme. Epson, HP, and Lexmark are inte-
grating Rendezvous into new printers; TiVo 
now offers Rendezvous-based functionality 
in its television recording devices; and other
manufacturers of peripherals and consumer
electronics are planning to release
Rendezvous-enabled devices.



PPD file installation
In Mac OS X, a PPD file can be used from any location on your system. However, it’s
best if you copy it to one of the system’s preferred locations. If the PPD file is in a 
preferred location, Printer Setup Utility either assigns the proper PPD file for your
printer when you create it or displays the PPD filename in a pop-up menu for you to
select. If a PPD file is not in one of the preferred locations, Printer Setup Utility asks
you to browse your system to locate it.

Within the Mac OS X preferred locations, you will notice that there are a number of
different folders in which PPD files can be stored. These folders are for localized lan-
guage versions of PPD files, and they have such names as en.lproj, fr.lproj, ja.lproj, and
so on. If the Mac will be used only in English, the English-language PPD is sufficient.

There are four preferred locations in which PPD files can reside. To add or remove files
from most of these locations, you must have administrator access privileges.

The example locations given here are for users working in English. If you will be work-
ing in another language, check whether there is also a localized version of the PPD for
that language. If so, first install the English-language PPD in one of the folders listed
below, then install the localized PPD in the equivalent folder for that language, such 
as fr.lproj for a French-language PPD. Note that if you are installing PPD files in your
home directory or the Classic System Folder, there are no lproj folders; all PPDs go into
a single folder.

• <startup volume>/Library/Printers/PPDs/Contents/Resources/en.lproj. This is
where you should install PPD files that will be used only by Mac OS X. PPD files stored
here are not available to applications running in Classic.

• <startup volume>/System/Library/Printers/PPDs/Contents/Resources/en.lproj.
This is where the system keeps any PPD files that it needs. As a rule, you should not
add PPD files to this directory. Nor should you remove any of the PPD files in the
directory. PPD files installed in this location are not available to applications running 
in Classic.

• <home directory>/Library/Printers/PPDs. If you don’t have administrator access to
the computer, this is the only place you can install PPDs. Even if you do have admin
privileges, you can use this location for PPDs for printers that only you will be using.
(You will have to create the PPDs folder inside the Printers folder before you can install
PPD files in it.) PPD files installed in this location are not available to applications 
running in Classic.

• <startup volume>/System Folder/Extensions/Printer Descriptions. This is the 
location where the Classic environment looks for PPD files. PPD files installed here are
also available to Mac OS X applications, provided that Classic has been run at least
once or the Classic System Folder has been selected at least once in the Startup Disk
pane of System Preferences. In other words, Mac OS X must know of the existence 
of the Classic System Folder to recognize the PPD files in this directory.

For a technical discussion of PPD files in Mac OS X, see developer.apple.com/
documentation/Printing/Conceptual/UsingPPDFiles/ppd_concepts/
chapter_2_section_1.html.

45Guide for Creative Professionals
Migrating to Mac OS X



Printer Setup Utility
Managing printers in Mac OS X is done with Printer Setup Utility rather than with the
Chooser as in Mac OS 9. Printer Setup Utility is located in the Utilities folder in the
Applications folder on your system volume.

Adding and configuring printers
Mac OS X recognizes and configures many USB printers as soon as you connect them
to your computer and turn them on. You can use Printer Setup Utility to select and
configure network printers. Mac OS X ships with drivers for today’s most popular USB
inkjet printers and also includes printer description files (PPDs) for more than 200
PostScript printers.

To add a new printer using Printer Setup Utility:

1. Choose Add Printer from the Printers menu (or click the Add button in the Printer 
List toolbar).

2. In the dialog that appears, use the pop-up menu at the top to choose the printing
protocol for communicating with the printer. (Be sure you choose a protocol that 
is supported by the printer.) If necessary, refine your choice (such as to select an
AppleTalk zone or a Windows workgroup) using the context-sensitive second 
pop-up menu.

3. Choose a printer from the list of devices and servers discovered on the network.

4. Choose a manufacturer’s name from the Printer Model pop-up menu. If Mac OS X
finds an appropriate PPD for that printer model, it displays the Auto Select option in
the Printer Model menu. Click Add to have Mac OS X select the PPD automatically.

5. If Mac OS X cannot find an appropriate PPD, or if you want to make sure which PPD
will be used, you can select a PPD manually. Open the Model Name menu and choose
the correct PPD, then click Add.

46Guide for Creative Professionals
Migrating to Mac OS X

PostScript and EPS data
Panther includes industry-leading conversion
technology that translates PostScript and
Encapsulated PostScript (EPS) data to high-
quality PDF data. Any Panther application 
can benefit from this built-in capability by
drawing high-resolution PostScript data
instead of a low-resolution bitmap onscreen,
and by printing PostScript-quality output 
on all printers—even non-PostScript devices.
Because Mac OS X uses the same PDF-based
text and graphics software for both screen
display and printing, it ensures that your 
documents will look the same on the screen
as they do when they’re printed.



You may subsequently need to choose printer-specific options (amount of installed
memory, optional paper trays, and the like) for your PostScript printers.

1. In Printer Setup Utility, select the printer from the printer list.

2. Click the Show Info button in the Printer List toolbar, or choose Printers > Show Info
from the Printer Setup Utility menu bar.

3. Choose Installable Options from the pop-up menu.

4. Select the appropriate options for the printer.

5. Click Apply Changes.

Setting a default printer
In Mac OS X, you choose the destination printer from the Printer pop-up menu in 
the Print dialog. You can quickly change printers without having to close the Print 
dialog; simply choose a different printer from the pop-up menu and select the 
appropriate output options (click the pop-up menu labeled Copies & Pages to see
additional options).

If you print to more than one printer, the last printer you used will be selected in the
Printer pop-up menu the next time the Print dialog appears. To change the destination
device, simply click the Printer pop-up menu and choose a different printer.

In Panther, you can change the default printer from the last printer used to a specific
printer. Open System Preferences and click the Print & Fax button. Then click the pop-
up menu next to “Selected printer in Print Dialog” and choose a printer. The printers 
listed are those in the printer list in Printer Setup Utility. To add a new printer, choose
Edit Printer List from the menu. Then click the Add button in the Printer List toolbar
(or choose Printers > Add Printer). Once you add the new printer, it will be the 
default printer.

Managing print jobs using desktop printing
In Mac OS X v10.3, desktop printers have returned to the Mac OS. Using desktop printers,
you can drag and drop to print files, immediately get information about what jobs are
printing or waiting in queue, or quickly access the printer’s utility. Just by glancing at
the printer’s icon in the Dock, you can tell if your job is printing or if there is an error.

The process of creating a desktop printer is very simple.

1. In Printer Setup Utility, create a print queue by choosing Printers > Add Printer, or 
create a printer pool by choosing Printers > Pool Printers.

2. Click the printer or pool in the printer list and drag it to the desktop or the Dock.
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Drag-and-drop printing
Once you create a desktop printer, you can drag files onto its icon to print to the 
associated printer. Files in a number of formats, including PostScript and PDF, will be
directly sent to print; other files will prompt the appropriate application to open and
present the Print dialog. If you drop a folder on the icon, a list of the folder’s contents
is printed.

To manage print jobs, simply double-click the desktop printer icon. A shortcut to 
the printer’s management utility is located in the desktop printer’s toolbar. Just click
the Utility button to check ink/toner levels or perform other hardware-related tasks.

Queuing jobs for later printing
If you’re not connected to your printer when you’re ready to print a job, you can hold
your jobs so they can be printed at a later time. To do that, follow these steps:

1. Open Printer Setup Utility and select your printer in the printer list or double-click its
desktop printer.

2. Choose Stop Jobs from the Printers menu or click the Stop Jobs button in the desktop
printer’s toolbar.

3. Return to your application.

4. Use the Print command in the application just as though you were printing now.

5. Choose the desired output options, then click the Print button (ignore the ! icon next
to the Printer pop-up menu).

6. In the dialog that appears, click “Add to Queue.”

7. When you are once again connected to your printer, open Printer Setup Utility and
select your printer (or open the desktop printer). Then choose Start Jobs from the
Printers menu (or the desktop printer’s toolbar).

Printer Pools and Printer Sharing
New to Panther are printer pools. If the printers you use are often busy and you want
to print a document as quickly as possible, you can create a collection of printers
called a printer pool. Your document automatically prints to the first available printer
in the pool. Because your file may go to any printer in the pool, you should place only
identical or at least very similar printers in the pool. It is also helpful if the printers are
in the same general physical location.

To set up a pool, follow these steps:

1. Open System Preferences and click Print & Fax.

2. Click Printing, then click Set Up Printers.
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3. Select the printers in the printer list that you want to be in the pool. (Select the first
printer, then hold down the Command key and click additional printers.)

4. Choose Printers > Pool Printers.

5. Type a name for the printer pool in the Printer Pool Name field.

6. Drag the printers into the order you prefer. When you print, your computer checks 
the first printer in the list for availability, then the next, and so on. The printer options
for the entire pool are taken from the first printer listed.

7. Click Create.

To let other computers on your local network access the same printers, turn on Printer
Sharing:

1. Open System Preferences and click Sharing.

2. In the Services pane, select Printer Sharing and click Start.

All printers in your printer list (in Printer Setup Utility) are shared, whether they are
connected directly to your computer or you access them over a network. Shared 
printers automatically appear in the submenu of the Print dialog on other computers
connected to your local network (your IP subnet).

To help others find out where to pick up their printed documents, open Printer Setup
Utility (in /Applications/Utilities). If the Printer List window is not open, choose View >
Show Printer List. Select a printer, then choose Show Info from the Printers menu and
type a clear description of the printer’s location in the Location field.

Documents waiting to print on your shared printers are stored on your hard disk. That
is, your computer hosts the queue for the printer.
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To learn more about setting up printer features, open Printer Setup Utility, choose 
Mac Help from the Help menu, and search for the feature you’re interested in.
Topics include:

• Creating a desktop icon for a printer
• Setting up to print to another Mac OS X user’s shared printer
• Assigning a print job to a different printer
• Setting up to print to a printer shared by a Windows computer via SMB
• Setting up to print to an IP Printing network printer

ColorSync Profiles
In Mac OS X, ColorSync is fully integrated into the operating system. In fact, Mac 
OS X v10.3 is the only operating system that fully supports the ICC version 4 standard
for managing color. This integration makes it easy for developers to build color 
management features into their applications, resulting in greater productivity and
higher-quality results.

You can assign an output profile to your printer using ColorSync Utility, then choose
where and how color is converted for your output device right from the Print dialog.
You can even use Preview to see a color-accurate onscreen “soft proof” of how your
file will print, including all settings you chose in the Print dialog.

A new Color Management Module (CMM) in Mac OS X increases the speed and 
precision of color transformations. It takes advantage of the power of the Velocity
Engine to dramatically speed up the most common color calculations, and the Apple
CMM uses multiprocessing whenever possible for further performance enhancements.
As a result, color matching in Mac OS X v10.3 is nearly twice as fast as in Mac OS 9.

If you have been using ColorSync in Mac OS 9, you can move your existing generic
profiles to your Mac OS X system. (See the next section for information on profile 
locations supported in Mac OS X.) “Generic” profiles are those installed by applications
that describe virtual devices, not actual devices. For example, the ColorMatchRGB.icc
and USWebCoatedSWOP.icc profiles installed by Adobe Photoshop are generic profiles.
Any custom profile for a specific color device—such as a printer, scanner, or display—
should be re-created on the Mac OS X system.

Profile locations
Where you install profiles in Mac OS X depends on which users you want to have
access to them. Here are the available locations:

• For all users of the same Mac system:
/Library/ColorSync/Profiles/

• For each individual user of the Mac system:
/Users/<username>/Library/ColorSync/Profiles/ 
(also referred to as ~/Library/ColorSync/Profiles/)

• For access over a managed network:
/Network/Library/ColorSync/Profiles/

Note that the operating system installs profiles in a read-only location,
/System/Library/ColorSync/Profiles/. Do not put your own profiles in this directory.

50Guide for Creative Professionals
Migrating to Mac OS X



Quartz filters
Quartz filters offer more advanced color matching capabilities. In addition, they can 
be used to add special color effects or to sharpen, blur, or change the resolution of
images. You can even use a filter to create an industry-standard PDF/X file. You can
also apply Quartz filters when you print a file or save it as a PDF document.

By applying Quartz filters at print time, you change how the document looks when it’s
printed without modifying the document itself.

1. Open the document you want to print.

2. Choose File > Print.

3. Choose ColorSync from the Copies & Pages pop-up menu.

4. Choose an option from the Color Conversion pop-up menu. Choose Standard if you
want the Mac you’re using to control the color management of the printed output
(available only when a profile has been registered for the printer). Choose In Printer 
if you want the printer you’re using to control the color management of the printed
output. (Non-PostScript printers use only standard color matching.)

5. If desired, choose an option from the Quartz Filter pop-up menu. Either choose an
existing filter from the list or choose Add Filters. Choosing Add Filters opens your 
document in ColorSync Utility, where you can create a new filter (see sidebar). When
you are finished using ColorSync Utility, quit the application; do not click Apply. Return
to the open document, choose File > Print, choose the ColorSync option, then choose
the new filter from the updated Quartz Filter pop-up menu.

6. In most cases, you can now click Preview to see a color-accurate soft proof that
includes the effects of the Quartz filter you’ve selected. When you’re done looking 
at the proof, close the Preview document window or quit the Preview application 
to return to the application you’re printing from.

7. Click Print.

Printing as PDF or PostScript
Mac OS X Panther includes PostScript-to-PDF conversion technology licensed from
Adobe Systems that translates PostScript and Encapsulated PostScript (EPS) data to
high-quality PDF data. This technology is integrated into Quartz 2D, the powerful
graphics system in Mac OS X. Quartz 2D draws PDF-based text, bitmapped graphics,
and vector graphics on the screen as well as on printers. Any Panther application can
take advantage of Quartz 2D to draw high-resolution PostScript/EPS data onscreen 
or to print PostScript-quality output on all printers, including non-PostScript devices.
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Custom Quartz filters
Several Quartz filters are included in Panther,
and you can also create your own custom 
filters. To create a new filter:

1. Open ColorSync Utility.

2. Select Filters from the toolbar.

3. Click the Add button.

You can then choose your filter settings and
decide whether to treat text, bitmap images,
vector graphics, and smooth shaders equally
or differently.

If you choose “View file with filter,” be sure 
to enable the Preview checkbox.

Tip: In the Filters pane of ColorSync Utility,
you’ll see a button labeled Domains. If you
click the PDF Workflow checkbox, your 
custom Quartz filters will appear under the
Save As PDF button in the Print dialog of
every Mac OS X application. (The PDF work-
flow button is hidden by default, but is
enabled if the system detects the existence 
of a /Library/PDF Services or ~/Library/PDF
Services directory.)

Tip: If you have an unlocked filter, you can
create custom transforms for it. In the Filters
pane, click the Color button, then choose
Custom from the “Intermediate transform”
pop-up menu. (The Custom option is at the
top of the list.)



Because PDF technology is built directly into the operating system, you can make PDF
files from any Mac OS X application—a great way to exchange documents with clients
and colleagues. After choosing Print from the File menu, simply click the Save As PDF
button instead of the Print button, and your document is converted to a PDF file that
is readable by Adobe Acrobat Reader, Mac OS X Preview, and other PDF viewers.

You can also save a document as a PostScript file. Just follow these easy steps:

1. Choose Print from your application’s File menu.

2. In the Print dialog, look for the pop-up menu that says Copies & Pages. Choose 
Output Options.

3. Click the “Save as File” checkbox.

4. Choose PostScript from the Format pop-up menu. If the PostScript option is dimmed
(not available), you have not set up a PostScript printer in Printer Setup Utility.

5. Click Save. Your document is saved as a PostScript file.
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PostScript and EPS data
In addition to its PDF file generation capability,
Mac OS X v10.3 “Panther” incorporates 
technology licensed from Adobe Systems to
convert PostScript (.ps) and Encapsulated
PostScript (.eps) files into Portable Document
Format (.pdf ) files.

Using the Adobe PDF technology in Panther:
• Preview can convert individual files.
• AppleScript Image Events and the pstopdf

command-line tool can batch process 
multiple files.

• The printing system can image high-quality
PostScript data on a raster printer (such as 
an inkjet printer).



PDF Workflows
In Mac OS X, it’s easy to save a document as a PDF. All you need to do is open the
Print dialog and click the Save As PDF button. Simply type a name for the PDF file,
choose where you want to save it, and click Save. Since the release of version 10.2.4,
Mac OS X has also offered advanced options for how to prepare the PDF file and what
to do with it. For example, you can specify which application should open the PDF file,
or you can optimize the file for onscreen viewing.

The PDF workflow button that provides these advanced option is hidden by default.
The button appears if the system detects the existence of either the /Library/PDF
Services or the ~/Library/PDF Services directory. To enable this button, you must 
manually create a PDF Services folder in one of those locations.

Once you’ve created a PDF Services folder, you can access PDF workflow options 
by clicking the PDF button in the Print dialog. All available options appear in a 
pop-up menu.

You can add a menu item to the PDF workflow pop-up menu simply by adding it to
any of the following directories:

• /Library/PDF Services
• ~/Library/PDF Services
• /Network/Library/PDF Services. Although any file you put in this directory shows 

in the workflow pop-up menu, the menu itself is visible only if the /Library/PDF
Services or ~/Library/PDF Services directory exists. The system does not check for 
a /Network/Library/PDF Services directory when it determines whether to hide or
show the PDF workflow button.

You can place the following items in any of those directories:

• A folder or an alias to a folder
• An application or an alias to an application
• A UNIX tool or an alias to a UNIX tool
• An AppleScript file or an alias to an AppleScript file

The type of item placed in one of the directories determines what the item does when
you select it from the PDF workflow menu. For example, if the item is a location (such
as a folder), the PDF file is copied to that location.

For more details on PDF workflows, including examples of how to use them to increase
your productivity, see developer.apple.com/documentation/Printing/Conceptual/
PDF_Workflow/PDF_Workflow.pdf and developer.apple.com/documentation/Printing/
Conceptual/PDF_Workflow/pdfwf_intro/chapter_1_section_1.html.
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Folders and folder aliases in PDF workflows
Folders or aliases of folders can also be used
in the PDF workflow. If you place a folder 
or alias in a PDF Services folder on your 
local hard drive (/Library/PDF Services or
~/Library/PDF Services) and then select it
from the PDF pop-up menu when you print,
the folder or folder alias triggers a copy
action. That is, the printing system creates a
PDF file and places it in the designated folder.
The name of the PDF file is the document’s
title as specified by the application that 
generated it, plus the .pdf extension. If there
is a naming conflict, the name is made
unique within the folder by appending 
a serial number.

For example, you might create an alias of
your iDisk Public folder and put it in the
~/Library/PDF Services directory. You can
then rename the alias to something mean-
ingful, such as “Copy PDF to Public Folder.”
This item now appears as a choice in the 
PDF workflow pop-up menu in the Print 
dialog. When you choose “Copy PDF to 
Public Folder” from the menu, the printing
system creates a PDF file and copies it to
your iDisk Public folder.



Working with Fonts

Mac OS X v10.3 “Panther” offers exciting type capabilities for design and print profes-
sionals, including support for several different font formats, new capabilities for 
rendering fonts, and the new Font Book application. Mac OS X currently supports 
fonts in the following formats: OpenType, Mac and Windows TrueType, Mac PostScript
Type 1, and Multiple Master created instances.

Font menus can grow quite long, making it difficult to find and use the fonts that are
so important to your projects. Font Book makes it easier to manage and find the fonts
you need. Managing fonts in Mac OS X Panther is similar to managing photos in iPhoto.
You create collections of fonts (similar to iPhoto albums), and then use the collections
to manage the fonts you want to use on your system at any given time.

Font Book is a powerful application for working with the fonts you need. It enables
you to install and preview fonts, search through them, create collections of fonts, and
disable, enable, and remove fonts. For example, Font Book makes it easy to customize
which fonts you see in each Mac OS X application, giving you quick access to the fonts
you need while not cluttering the font menu with ones you don’t.

Font Book works best for users who would like to put all of their fonts in it and then
use it to build customized font collections. Font Book will easily handle most users’
day-to-day font needs. Creative professionals who frequently deal with many fonts
from many different clients may be using a third-party font manager. Because Font
Book is a separate application rather than part of the operating system, it does not
interfere with third-party font managers.

For more information about Font Book, see Appendix G. For information about third-
party font managers, see Appendix H. For a comprehensive overview of fonts and font
technology in Mac OS X, see the white papers available at www.apple.com/pro and
www.apple.com/macosx/features/fontbook.
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Mac OS X font highlights
• Extensive font and character library
• Support for standard font formats such as

OpenType, TrueType (Mac and PC), Adobe
Type 1 PostScript (Mac), and PostScript
Multiple Master instances

• More than 100 included fonts
• Broad international language support, with

professional-quality fonts for Japanese,
Chinese, Thai, Korean, Arabic, and Cyrillic-
based character sets

• Full support for the Unicode 4.0 character set 



Where to Install Fonts
In Mac OS X, fonts can be installed in a number of places in the file system. This is 
due in part to the fact that Mac OS X is a multiuser operating system. A font can be
installed in a location that is private to a single user, one that can be shared by all
users of a computer, or even one that’s available to Classic applications.

Font Book makes font installation easy and seamlessly manages fonts in any of the
system locations. Double-clicking a font file (or a group of fonts) in the Finder opens 
a preview of the font, with the option to install it in just one click. Where the font is
installed and whether it is moved into the system location or copied to the location 
is controlled by the preferences you set for Font Book before starting to use it to 
manage fonts. Moving fonts is the default preference, but many creative professionals
may want them copied instead.

Once a font is installed, you can preview it in different ways from the Preview menu:

• Sample. Shows the font using a standard alphabetical list of characters.

• Repertoire. Displays the entire list of characters available in the font.

• Custom. Illustrates what a custom string of text looks like in the font. (This is the only
mode that allows you to type into the preview window.)

In all font preview modes, you can zoom in and out to view a font in a wide range 
of sizes.

A Mac OS X system has the following built-in font locations. In organizing your fonts,
note that Mac OS X recognizes fonts contained in subfolders inside these folders.

• Computer Fonts folder (/Library/Fonts/). This is the equivalent of the traditional
Fonts folder in Mac OS 9. Fonts in this folder are available to everyone who uses the
computer. However, only a user with administrator access can change the contents 
of the folder. Fonts in this folder are not available to Classic applications.

• User Fonts folder (~/Library/Fonts/). Only the individual user can use these fonts.
Also, they are not available to Classic applications.

• Classic Fonts folder (<Classic System location>/System Folder/Fonts/). If you’re 
running both Classic and Mac OS X applications and you don’t use a font manager,
this is the place you should put all your fonts. Both Classic and native Mac OS X 
applications can use these fonts.

• System Fonts folder (/System/Library/Fonts/). This folder contains the fonts used by
Mac OS X for menus, dialogs, and icons. It should not be used for your own fonts. You
can see the fonts here, but you can’t easily modify this folder. (The document ”Using
and Managing Fonts in Mac OS X” at www.apple.com/creative/fonts describes how to
do so.) Do not remove the font Lucida Grande from this folder, or the computer will
not start up.

• Adobe fonts folder (/Library/Application Support/Adobe). This folder contains 
additional fonts available only to Adobe applications. The fonts can be moved to a
more central location where they can be managed by a font manager.
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Keynote
Apple’s Keynote presentation software,
which is increasingly popular among graphic
arts professionals, makes full use of the
advanced font and graphics capabilities in
Mac OS X, including the Font panel. Keynote
is more than just a presentation tool. You 
can use it to build digital design portfolios,
animated storyboards, and dynamic 
photographic shows. The high-quality
graphics support in Keynote allows creative
professionals to import assets from
QuickTime, Adobe Photoshop, Adobe
Illustrator, Macromedia Flash, and Apple’s 
iLife applications.

Japanese system fonts
For Japanese localized systems, do not
remove the following fonts:

• Hiragino Kaku Gothic Pro W3
• Hiragino Kaku Gothic Pro W6 
• Hiragino Mincho
• Lucida Grande



Font Panel
New to Mac OS X is the Font panel. In some applications built for Mac OS X (such as
Apple Mail and TextEdit), the Font panel organizes fonts into useful collections. You
can organize your own font collections—for example, by client or job—or add fonts to
a favorites menu. Professional applications such as Adobe InDesign and QuarkXPress
use their own font selection tools.

You can use the Font panel to add effects such as underlining, strikethrough, fore-
ground and background color, and shadows to your fonts. You also get direct access
to the new Typography panel, which allows you to vary font features such as kerning
and number spacing and to create effects such as ligatures and swashes. A menu in
the bottom-left corner of the Font panel provides direct access to Font Book and 
adds access to the Typography panel. Once you’ve set your defaults, you can shrink
the Font panel to show only pop-up menus and leave it conveniently in a corner of
your screen.
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Unicode
Because it is based on the Unicode 
Standard, Mac OS X supports multiple 
languages—including Japanese, Chinese,
Traditional Chinese, and Korean—in the 
same document, without requiring additional
software. The Unicode Standard supports
96,000 characters, enough for all the world’s
languages and symbols. As long as an 
application supports Unicode, it can include
characters from different languages and 
different alphabets in a single document 
or web page and deliver it over multiple 
platforms, languages, and countries. The
Unicode Standard is supported in many 
operating systems, all modern browsers,
and many other products. It therefore 
represents one of the most significant
advances in global software technology.



Character Palette
In addition to the Font panel, Mac OS X has a feature called the Character Palette.
The Character Palette is useful when you need to find a specific character or symbol,
regardless of font. In addition to providing a view of characters by font as the Font
Book preview does, the Character Palette lets you view individual characters grouped
in various categories.

You can view the Character Palette in three ways:

• Special Characters. In Mac OS X Panther, the Edit menu in many applications has an
item called Special Characters that displays this palette.

• International menu. If you have enabled the Input Menu in the International pane of
System Preferences, you have a menu in the menu bar for accessing the Character
Palette along with other input methods.

• Font panel menu. Select the Characters item from the Action menu in the lower-left
corner of the Font panel.

To use the Character Palette from the Mac OS X menu bar, you must first turn on the
palette in the International preference pane. Do the following:

1. From the Apple menu, choose System Preferences.

2. Select the International pane.

3. Select the Input Menu tab.

4. Click the Character Palette checkbox.

To open the palette, choose Show Character Palette from the Input menu (the one
with the Character Palette symbol or the flag).

To enter a character, choose the items you want to see from the View pop-up menu.
Select the category of characters in the left column and double-click the character or
symbol you want to enter in the right column.

Click the triangle at the bottom of the palette to see more options, such as the font
you want to use.
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Font Managers
If the fonts you use change from day to day or project to project, using a font manager
will greatly simplify your workflow. If you decide to use a font manager in Mac OS X
and you also have one installed in Mac OS 9, be sure to disable the font manager in
Mac OS 9. If you were using ATM Deluxe as your font manager and you have to dis-
able it, you will need to install ATM Light to get smooth type in Classic applications.

Font Book and third-party font managers can exist on the same Macintosh system.
However, only one of them should be used to activate and deactivate fonts.

Other Mac OS X Font Features
Mac OS X comes with some Unicode TrueType fonts that have a dfont extension.
These are TrueType fonts with all their information in the data fork rather than in the
resource fork as in older Macintosh TrueType fonts. dfonts work only on Mac OS X 
systems and only in Mac OS X (not Classic) applications.

Many dfonts, such as Zapfino, contain extended characters in the Unicode part of the
font that designers may want to use. To access the extended characters in the font,
an application must be Unicode enabled. Adobe InDesign and TextEdit are Unicode-
enabled applications. You can use the Character Palette to see the extended characters.

If you have documents that use other versions of the same named font (such as
Helvetica) in a PostScript version rather than in the included dfont version, you will
want to make sure that the same font is used for output as was used during the 
original design of the document. Otherwise, the differences between the versions 
may cause type to reflow or glyphs to be substituted. To ensure that the correct 
version of the font is used, you can do one of the following:

• Activate the replacement font in Font Book.
• Remove the font and replace it with your version.
• Remove the font and use a third-party font manager to open the new version.
• Convert the output file to a PDF and embed all fonts.

To simplify verification of which font is actually in use, and to get a “font missing” alert
message from an application when a file created by that application is opened, many
users remove or disable all nonessential fonts, then open the set of fonts sent with the
job. In this situation, when you open the file, you’ll see an alert for any fonts that are in
the document but not in the font set you received from your client. This is a very fast
way to verify the fonts necessary for printing the document and to ensure that only
the customer’s font versions are used.

Font Book can be used to disable fonts without removing them, although this 
“disabling in place” approach is not recommended in a prepress environment because
fonts in the system-level font folders are automatically active unless they are explicitly
deactivated through Font Book. Mac OS X disables individual fonts by creating a 
preferences file called com.apple.ATS.plist for each user. This file tells the operating 
system which fonts are disabled. Although fonts installed in the system-level font 
folders can be overridden by a font manager, you will not get a “missing font” warning
from an application if the system font is always on. In addition, if the Font Book prefer-
ence file is accidentally deleted or rebuilt, any fonts in the system-level font folders
revert to their active state. You may not notice this reactivation, creating a risk of 
accidental font substitution by the once-again-active font.
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Mac OS 9 and font suitcases
When organizing your fonts in Mac OS X,
you may encounter a font file that started 
as a font suitcase on a Mac OS 9–based 
computer. Such suitcases sometimes contain
both TrueType and PostScript versions of 
the same font name. The Mac OS X font 
utilities that are currently available will open
and use both fonts that have the same 
name, creating a conflict.

To prevent problems, the best practice is to
extract all screen fonts from the suitcase 
and then install the specific fonts you need 
in your font manager. You can either open
the suitcase in a Finder window on a Mac
that has been started up in Mac OS 9 or 
earlier and extract the fonts that way, or 
you can find and install a copy of Font/DA
Mover 4.1 and run it in the Classic environ-
ment to disassemble the suitcase.



Essential fonts for Roman language Mac OS X systems include Lucida Grande, Last
Resort, Keyboard, Monaco, and Geneva. Do not remove any of those fonts; in particular,
if you remove Lucida Grande, the computer will not start up.

Remember that if you use dfonts and you will be printing the final piece on a different
system, the output system will have to be a Mac OS X system that either already has
these dfonts loaded or is able to load your dfonts. If the job is to be output on a Mac
OS 9 system, you need to make sure that the service bureau has a Mac OS 9 version 
of the dfont with exactly the same font metrics and glyph shapes as your Mac OS X
version. (Installing your dfonts on the output system is not necessary with dfonts that
are embedded in PDF documents. Those will print fine from any system that can print
PDF files.) 

Font rasterization is now built into the operating system, so Adobe Type Manager 
is not needed for that purpose. (You will need to install ATM Light in the Mac OS 9
System Folder to get smooth type in Classic applications, because ATM Deluxe does
not work on Mac OS X systems.)

Beginning with Mac OS X v10.2, support for single-instance Multiple Master fonts 
has been built into the operating system. However, Adobe InDesign 2, Photoshop 7,
Illustrator 10, and Acrobat 6 do not currently recognize these instances if they are
installed in one of the standard Mac OS X font locations. These applications support
Multiple Master fonts only if they are placed in one of the Adobe-specific directories,
/Library/Application Support/Adobe/Fonts/ or ~/Library/Application Support/
Adobe/Fonts/.
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Sharing Files and
Computers

Mac OS X makes it easy to work with users of other systems in a number of ways.

If possible, you should have your system administrator set up Mac OS X Server, Apple’s
powerful, flexible platform for workgroup services. Mac OS X Server combines the 
latest open source technologies with Apple’s industry-leading manageability and ease
of use. The result is an open, UNIX-based server platform that’s easy and affordable 
to deploy and maintain. And because it is based on open standards, Mac OS X Server
can easily integrate with your existing network infrastructure and provide services for
mixed-platform environments.

If you don’t have access to Mac OS X Server, you can use built-in Mac OS X features
along with third-party software as needed.

Public Folder
You can make your Public folder accessible to other users by turning on Personal File
Sharing in the Sharing pane of System Preferences. By default, your Public folder and
the folders within it are the only ones that can be shared. For alternative solutions, see
Appendix H.

Important: If you choose to change the access privileges of folders other than your
Public folder, take care that you do not inadvertently allow other users access to 
personal files or confidential information.

In addition to Personal File Sharing, which uses the Apple File Protocol, files in your
Public folder can be shared with Windows computers via Samba, and with a wide
range of platforms through FTP.

If you have a .Mac account, you can put files in the Public folder of your iDisk, where
they can be viewed or copied by anyone who knows your .Mac member name and
can access iDisk Public folders. For wider access, use the HomePage application in .Mac
to set up a file-sharing page that allows everyone with Internet access to copy items
from your Public folder, regardless of whether they are .Mac members or what type of
computer they use.
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Drop Box
To give a copy of a file to someone who uses the same computer or a different 
computer that’s networked to yours, you can copy it to the person’s Drop Box folder.

To give a file to someone who uses your computer, open the person’s Public folder (in
his or her home folder in the Users folder on your hard disk) and copy (Option-drag)
the file to the Drop Box folder.

To give a file to someone who uses another computer on your network, choose
“Connect to Server” from the Go menu and connect to the user’s computer. (Guest
logins work fine for this; you don’t need to be a registered user of the computer.) 
Then drag the file to the Drop Box folder. If you can’t find someone’s Public folder 
on the network, make sure the person has file sharing turned on.

Shared Folder
At the same level as the individual users’ folders is a folder called Shared. This folder is
often used by applications to store preferences needed by all users, but it can also be
a convenient place to store data files that all users of the computer need access to.

Fast User Switching
With the Fast User Switching capability in Panther, you can share a Mac with other
users quickly and effortlessly. Fast User Switching resolves the conflicts experienced 
in households, offices, and schools where people share computers by allowing users
to quickly switch between active accounts without having to quit applications and
completely log out. While another user works on the computer, your account remains
active in the background, with applications running, documents open, and active tasks
like file transfers continuing.

While an account is switched out, the UNIX-based security technology in Mac OS X
ensures that all of the user’s data and applications remain completely secure. The new
user cannot access the documents of the account that is switched out.
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iChat AV
iChat AV, a new feature in Mac OS X Panther,
introduces a video conferencing solution that
makes it easy to have natural conversations
with other Panther users over the Internet—
perfect for reviewing comps or anything 
else where visual interaction is important.
Because iChat AV is compatible with AOL
Instant Messenger, you can also chat with
clients and colleagues who use AOL, simply
by signing on to iChat AV with your .Mac 
or AIM user account.

iChat AV features high-quality, full-screen
video; crystal-clear, full-duplex audio; a 
familiar, easy-to-use interface; and setup 
that is immediate and effortless.* iChat AV
works with iSight and other FireWire-based
cameras, including DV camcorders. In addi-
tion to audio and video conferencing, you
can use iChat AV to transfer files that are too
large to send via email, such as for reviewing
work with satellite offices or clients.

iChat uses two methods to connect users:
over an external chat network, such as 
AOL, or over an internal network. Apple’s
Rendezvous technology allows iChat users 
to automatically discover other users on 
the network who are available for text, audio,
or video conferencing. You don’t need to
enable or open your firewall to other chat
protocols to use iChat on an internal net-
work. For instance, a production or traffic
manager could receive a file from a designer
and instantly transfer it to another user 
using iChat over Rendezvous, speeding up
the workflow.



Appendix A:
Mac OS X Quick Reference

Finder Commands and Shortcuts
Some of the keyboard shortcuts in the Mac OS X Finder are different from those in
Mac OS 9. Here’s a reference chart for some of the most-used ones.

Shortcut Mac OS 9 function Mac OS X function

Command-H Search Internet Hide Finder

Option-Command-H — Hide other applications

Command-N Make new folder Make new Finder window

Shift-Command-N — Make new folder

Command-P Print window —

Command-L — Make alias

Command-M Make alias Minimize window

Command-C Copy (item names only) Copy (items or names)

Command-V Paste (in item names only) Paste (items or names)

Command-Y Put away (desktop item) —

Some shortcuts have been added in Mac OS X to support new Finder features.
Mac OS X Panther ships with the following default shortcuts, but you can customize
keyboard shortcuts for the system as well as for individual applications.

Shortcut Mac OS X function

Command-[ Go back

Command-] Go forward

Command-1 Icon view

Command-2 List view

Command-3 Column view

Shift-Command-A Go to Applications folder

Shift-Command-C Go to Computer folder

Shift-Command-G Go to folder (enter name)

Shift-Command-H Go to home folder

Shift-Command-I Open iDisk folder

Command-K Connect to server

Command-Option-T Show/Hide toolbar

You’ll find a list of Mac OS X keyboard shortcuts at
docs.info.apple.com/article.html?artnum=75459.
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Mac OS 9 vs. Mac OS X Organization
Mac OS X stores items in slightly different locations than Mac OS 9. Here’s a listing of
some of the major changes.

Mac OS 9 element Mac OS X equivalent

Chooser printer options Printer Setup Utility in Utilities folder in Applications folder

Chooser AppleShare options Connect to Server in Finder Go menu or Network 
icon in Finder windows

Fonts folder in System Folder Fonts folder in Library folder

Sounds Sounds folder in Library folder in home folder

Utilities folder Utilities folder in Applications folder

Apple Extras folder Applications (Mac OS 9) folder

Internet folder System Preferences

Mac OS 9 applications Applications (Mac OS 9) folder

Desktop items Desktop folder

Documents folder Documents folder

Sleep, Restart, and Shut Down Apple menu

Special menu Apple menu

Finder preferences Finder application menu

Application preferences Application menu in the application

Control panels System Preferences

File Sharing Sharing pane in System Preferences

Software Update control panel Software Update pane in System Preferences

SimpleText TextEdit

TCP/IP control panel Network pane in System Preferences

AppleTalk control panel Network pane in System Preferences

AirPort control panel Network pane in System Preferences

Modem control panel Network pane in System Preferences

Remote Access control panel Network pane in System Preferences

Location Manager Network pane in System Preferences

Multiple Users control panel Accounts pane in System Preferences

Assign Startup items Startup Items in Accounts pane in System Preferences 

Extensions Manager No longer necessary

Disk First Aid/Drive Setup Disk Utility in Utilities folder in Applications folder

Favorites Apple menu item Favorites folder in Library folder in home folder

Find command in Finder File menu Find command in Finder File menu
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For items in Library folders, check three
places: the hard disk Library folder, the
System Library folder, and the home Library
folder. Still can’t find something? Use the Find
command from the File menu in the Finder.



Hard Disk Contents
The following folders, which are at the computer level, are available to all users of 
the computer.

• Applications. Mac OS X applications available to all users of the computer.

• Applications (Mac OS 9). Mac OS 9 applications, Internet, Utilities, and Apple 
Extras folders.

• Documents. Folders and files stored in Documents folder with Mac OS 9.

• Library. Fonts, plug-ins, preferences, and other items for all users of the computer.

• System. Mac OS X system software files.

• System Folder. Mac OS 9 system software files.

• Users. Your home, homes of other user accounts, and the Shared folder where you 
can share files with others.

• Desktop (Mac OS 9) folder (located on the desktop). Items previously on the 
Mac OS 9 desktop.

Home Folder Contents
Home is where you keep your own files. You can use these default folders and add
new ones to organize your files.

• Desktop. Items on the Mac OS X desktop for your home.

• Documents. Your document files and folders.

• Library. Fonts, plug-ins, preferences, and other items for your use.

• Movies. Location to store movies.

• Music. Location to store audio files.

• Pictures. Location to store image files.

• Public. Folder where other users can view your files; Drop Box folder for others to
leave files for you.

• Sites. Your web pages that can be viewed by others using Web Sharing.
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Appendix B:
Supported Devices

Right out of the box, Mac OS X supports a wide range of printers, cameras, storage
media, and other external devices. Check the list at www.apple.com/macosx/upgrade/
devices.html for the latest information or visit the sites listed here for information on
Mac OS X support for specific types of devices.

Printers
Go to www.apple.com/macosx/upgrade/printers.html.

If you have a printer that doesn’t currently have a driver included with Mac OS X,
you can check gimp-print.sourceforge.net/MacOSX.php3 to see whether your printer 
is supported by Gimp-Print. Gimp-Print is an open source programming project that 
provides printer drivers for a variety of printers, including Canon, Epson, Lexmark,
and PCL printers.

Scanners
Go to www.apple.com/macosx/upgrade/scanners.html.

See Appendix H for additional resources for scanner drivers.

Digital cameras
Go to www.apple.com/macosx/upgrade/cameras.html.

Monitors and projectors
Go to www.apple.com/macosx/upgrade/monitors.html.

Storage devices
Go to www.apple.com/macosx/upgrade/storage.html.

Input devices
Go to www.apple.com/macosx/upgrade/input.html.
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Open source software projects
Open source software is simply software
whose source code is available to anyone
interested in looking at it. Open source 
software is developed in a collaborative 
way with contributions from programmers 
all over the world. Open source applications
are usually of very good quality and are 
free to the end user. For more information,
visit the Open Source Initiative website at
www.opensource.org.



Appendix C: Working with 
a Multiuser System

Several people can share a Mac OS X–based system by logging in to their individual
user accounts. Each user has a home directory, which can be located on the computer
or on a network server. Each user’s system and application preferences (such as 
bookmarks and desktop views) are kept in his or her home directory, providing a cus-
tomized experience for each person. Each user can control access to his or her private
files while safely sharing selected files with other users. All users sharing the computer
also have access to a common Shared folder. A designated administrator can control
the access of other users, such as to restrict access to certain programs and functions.

Automatic login can be enabled on a Mac OS X system, but you should be cautious
about enabling it if more than one person uses the computer. If the auto-login
account has administrator privileges, all users starting up the Mac would have those
privileges. They would also have access to the automatically logged-in user’s documents.
In addition to the potential security ramifications, any other user would have to log
out and log back in to access his or her own account and files. If you do want to use
auto-login on a multiuser Mac, it would be best to set up a restricted guest account
for this purpose. Authorized users can then log out of the guest account and back 
in as themselves to get their individual privileges and documents.

Administration and system security
The first user account created on your computer is designated an “administrator.”
Administrators are users with special privileges: They can create new user accounts,
install software, and change general computer settings.

If you forget the administrator password, you can reset it using the Mac OS X CD. Start
up from the Mac OS X Disc 1 CD and choose Reset Password from the Installer menu.

If you need a higher level of security, you can use Open Firmware Password
Protection, which prevents anyone (including you) from accessing the computer 
without the Open Firmware password. For information, see docs.info.apple.com/
article.html?artnum=106482.
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You can require a password to access the computer after the screen saver appears, in
case users log in and leave the computer unattended. Use the Desktop & Screen Saver
pane in System Preferences to turn this feature on.

If you are a mobile user and you work on sensitive documents, you can protect those
documents with FileVault, a new feature in Mac OS X Panther. FileVault secures the
contents of your home directory with powerful AES-128 encryption. Encryption and
decryption take place in the background, so FileVault won’t slow down your work.
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Appendix D:
Support Programs and
Maintenance Tips

When you purchase a new Apple computer, you receive 90 days of telephone support
and one year of service coverage at an Apple-authorized repair center. Your new 
computer also comes with some great tools to help you use it more effectively. You
can use the onscreen Mac Help Center to find step-by-step instructions and trouble-
shooting information. Product manuals and online resources are also available at
www.apple.com/support.

Apple Support and Purchasing Options
In addition to built-in support, Apple offers a full range of award-winning service and
support programs and purchasing plans. These options provide creative professionals
and their organizations with long-term peace of mind and economical ways to keep
their software current.

• AppleCare Protection Plan. You can purchase the AppleCare Protection Plan to
extend the complimentary coverage on your Mac to three years from the computer’s 
purchase date. This comprehensive plan includes expert telephone assistance, onsite
repairs for desktop computers,** global repair coverage for portable computers, web-
based support resources, and powerful diagnostic tools at an economical price. One
phone call with an AppleCare representative can help troubleshoot most issues with
your Apple hardware, Mac OS X, and many of Apple’s built-in applications.

The AppleCare Protection Plan must be purchased while your Apple system is within
its one-year warranty. It is recommended that you purchase the plan when you 
purchase your system to take maximum advantage of the coverage it provides.
For more information about this and other Apple support products, visit
www.apple.com/support/products.

• Apple Volume Licensing. The Apple Volume License Program offers organizations 
the most cost-effective means of acquiring multiple licenses for a specific release of
Apple software. Customers can enter the program with a minimum purchase of 10
software licenses. Software eligible for volume license discounts includes Mac OS X,
Mac OS X Server, Final Cut Express, Final Cut Pro, DVD Studio Pro, Keynote, Soundtrack,
AppleWorks, QuickTime, and QuickTime Pro. (Software and documentation is not
included in the license fee but can be purchased separately.) For more information,
visit store.apple.com/AppleStore/WebObjects/BizCustom?qprm=78313&family=
VolLicense.

• Apple Maintenance Program. The Apple Maintenance Program is a three-year sub-
scription entitling customers to every major release of a particular Apple software
product delivered during the term of the maintenance contract. Eligible products
include Mac OS X, Mac OS X Server, Final Cut Express, and Keynote. The program is
cost-effective and offers tiered pricing. To enroll, you must be using the most current
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major release of the software. The Apple Maintenance Program is the ideal way 
to manage your organization’s software investment while benefiting from future 
Apple software innovations. For more information, visit store.apple.com/
AppleStore/WebObjects/BizCustom?qprm=78313&family=Maintenance.

System Maintenance Tips
Because Mac OS X is based on the UNIX operating system, system maintenance is
somewhat different than with Mac OS 9. A number of standard UNIX utilities—many
of which now have easy-to-use Macintosh graphical interfaces—and Macintosh-
specific utilities are included with Mac OS X.

To keep Mac OS X running well, use Software Update or visit the Apple website 
regularly for security, operating system, and Apple application updates. You can set
Software Update to check for updates daily, weekly, or monthly.

Fixing file system errors
Many file system errors are minor and not even noticeable, but occasionally they may
prevent the computer from starting up in a normal state. This could occur after an
improper shutdown, a forced restart, or a power interruption.

If your system does not complete its startup successfully, you should use a disk repair
utility. First try a feature introduced in Mac OS X v10.2 called Safe Boot. It may allow
you to restart successfully using a reduced version of system software. During this
restart, a disk check and repair are performed that may resolve your issue. If they do,
you do not need to take any further action.

Follow these steps to see whether Safe Boot will resolve the issue:

1. Restart the computer (using the Power button or Reset/Interrupt button if necessary).

2. Immediately after the system startup sound, press and hold the Shift key until Safe
Boot appears on the screen. (Note that there may be a considerable delay before this
happens, particularly on larger startup volumes, because the disk check and repair
take place before Safe Boot appears.)

3. After the system is fully started up, restart again normally.

If the restart is successful, you do not need to do any more troubleshooting.

Disk Utility
If the Safe Boot disk repair is not successful, try verifying and repairing the internal
disk using Disk Utility from a Mac OS X startup CD.

1. Insert your Mac OS X CD or Restore DVD disc, then restart the computer while holding
down the “c” key.

2. When the system has started up, choose Disk Utility from the Installer menu.
Important: Do not click Continue in the first screen of the Installer. If you do, you 
must restart from the disc to access Disk Utility.

3. Click the First Aid button.

4. Click the disclosure triangle to the left of the hard disk icon to display the names of
your hard disk volumes and partitions.

5. Select your Mac OS X volume, if it isn’t already highlighted.

6. Click Repair. Disk Utility checks the disk.

7. Start up the computer again, this time from your normal startup disk.
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Repairing permissions
Sometimes the privileges or permissions of items in the file system become modified
in such a way that an application may crash or not function properly. Disk Utility can
repair the permissions of operating system files and directories.

1. Open Disk Utility (in /Applications/Utilities/).

2. Click the First Aid button.

3. Click the disclosure triangle to the left of the hard disk icon to display the names of
your hard disk volumes and partitions.

4. Select your Mac OS X volume, if it isn’t already highlighted.

5. Because this is your system volume and you are running Disk Utility from it, the nor-
mal Repair Disk and Verify Disk options are disabled, but you can select Verify Disk
Permissions or Repair Disk Permissions.

6. Click Repair Disk Permissions. Disk Utility repairs the permissions on the volume.

To ensure that permissions are properly set, you may want to repair permissions after
you install a new application or a software update.

Backing up your files
Mac OS X has built-in functionality for creating a master backup of your base system
configuration. This base configuration can include all of your installed applications and
any customizations you make to your system. You can then create a disk image from
which you can restore your system configuration in case the hard drive ever becomes
damaged. The restoration is performed with Disk Utility. It can be performed across a
network or from another disk that the target computer is started up from.

Third-party file backup products are also available; see Appendix H for information.

Disk optimization
In the past, many Mac users have relied on disk optimization to improve access times
when reading files from a hard drive. As files are changed and the hard drive fills up,
parts of a single file may be stored in different locations on the volume. In other
words, the file becomes fragmented.

Disk optimization streamlines the physical locations of files by collecting file fragments
and putting them back together in contiguous parts of the drive. Rearranging files
(and metadata) improves data access times and minimizes the time required to move
the hard drive’s read/write head. However, if a failure (such as power loss) occurs 
during optimization, files can be damaged, and you will need to restore them from a
backup copy.

Once you have migrated to Mac OS X, you may not need to optimize your disk at all.
Here’s why:

• Hard disk capacity is generally much greater now than a few years ago. With more
space available, the file system doesn’t need to fill up every nook and cranny.

• The Mac OS Extended (HFS+) file system format avoids reusing space from deleted
files as much as possible. This avoids prematurely filling small areas of recently 
freed space.

• Mac OS X v10.2 and later versions include delayed allocation for volumes that use 
the Mac OS Extended format. This design allows a number of small allocations to be
combined into a single large allocation in one area of the disk.
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• Fragmentation was often caused by continually appending data to existing files. With
faster hard drives and better caching, as well as changes to the ways applications work
on Mac OS X, many applications simply rewrite the entire file each time. Mac OS X
Panther can also automatically defragment such slow-growing files.

• Aggressive read-ahead and write-behind caching means that minor fragmentation 
has less effect on perceived system performance.

• Mac OS X systems have hundreds of thousands of small files, most of which are rarely
accessed. Optimizing them is a major effort for very little practical gain. There is also 
a chance that one of the files designated for rapid reads during system startup might
be moved during defragmentation, which would actually decrease performance.

For all of those reasons, there is usually little benefit to defragmenting a hard drive 
on a Mac OS X system. However, if your disks are almost full and you often modify 
or create large files, there’s a chance they could be fragmented. In this case, they
might benefit from defragmentation. A number of third-party utilities are available 
for this purpose.
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Appendix E:
Troubleshooting

Here are some basic suggestions for troubleshooting a Mac OS X–based system. If 
you try these recommendations and the problem persists, check out additional Apple
support options at www.apple.com/support/products and the Apple support data-
base at www.info.apple.com. Also check the support website of the developer of a
product you are having a problem with.

You can find information about books on using and troubleshooting Mac OS X at
www.apple.com/macosx/resources.

New Hardware or Software
If you installed new hardware or software shortly before the problem started, try the
following suggestions.

Hardware 
• Check the RAM, storage drives, adapter cards, and USB devices.

• Remove the device and retest for the problem.

• Swap user-changeable components (such as RAM) with other like hardware that is not
experiencing the problem.

• In a professional publishing environment, it’s recommended that you keep at least
5GB to 7GB of disk space available at all times. Performance issues are sometimes due
to low disk space.

Software 
Potential problem sources include virus software, fonts, utilities, and application 
preferences.

• Run Repair Disk Permissions in Disk Utility before and after every software installation.

• Check the developer’s website to make sure that you have the latest version of the
software and that it is compatible with Mac OS X v10.3. Uninstall the suspicious appli-
cation and retest without it.
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Sometimes software problems are specific to a certain user account. To determine
whether this is the case, create a new user, then log in as that user and test for the
problem again. If the problem no longer occurs, you may want to move your data 
to the new account and delete the old one. Follow these steps:

1. Log in as the original user.

2. Move all of your data to the Shared folder.

3. Log out.

4. Log in under the new account.

5. Move the data from the Shared folder to the appropriate folders in your new account.

6. Delete the old account, including any folders it owned.

As always, be sure to back up your hard drive before deleting data.

Preferences
Sometimes the preferences for an application become corrupted. In this case, you need
to throw out the corrupted file and create a new preferences file for that application.

Preference files are typically stored in two places in the system. The first location is a
user’s Library/Preferences folder (~/Library/Preferences); preferences stored here are not
shared by other users. The other location is the startup volume’s Library/Preferences
folder (<startup volume>/Library/Preferences); it contains preferences shared by all
users. In either folder, look for an <application name>.plist file that contains your cus-
tom settings for an application. Move the file out of the folder so that the application
can’t find it and open the application again. The software creates a new preferences
file. If this fixes the problem, delete the old preferences file.

Check with the developer of your application for advice on when to perform such 
a task and which settings it affects. You can also search the Apple support site
(www.info.apple.com) using the query term “plist” to see which items in Mac OS X
might be affected by a damaged plist file.

System Caches
To improve the performance of Macintosh systems, various pieces of information are
stored in caches for fast access. Occasionally, one of these caches can be damaged.
Typical problems resulting from a damaged cache include fonts that display incorrectly
or printers that no longer seem to function. You can delete damaged caches in 
the Finder.
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Clean Installation
When none of the preceding steps works and you have established (by running Disk
Utility) that the hard disk is not damaged, you will need to archive your data and 
perform a clean installation of Mac OS X.

If the problem you are experiencing is network related, do not keep your current 
network settings as part of the reinstallation. If you use the Archive and Install option,
you may need to reinstall some applications, but for the most part, your data will be
preserved. The previous System folder is placed at the top level of your hard drive.
It is no longer usable, but you can move items out of it into the new System folder.
Do not delete the previous System folder until you are sure you have copied all the
files you need from it. See the section “Installing Mac OS X” for details on the Archive
and Install option.

Additional troubleshooting resources can be found in Apple’s Knowledge Base:
docs.info.apple.com/article.html?artnum=25392.

If you need more information about system font caches (fontTablesAnnex), see
docs.info.apple.com/article.html?artnum=25398.
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Appendix F: Formatting
Your Hard Disk

You will rarely need to reformat a hard disk before installing Mac OS X. However, if you
encounter serious problems while verifying the file system, or if the disk is not current-
ly in Mac OS Extended (HFS+) format, you will need to reformat it.

Formatting a volume on your hard disk permanently erases all the files contained in it,
so make sure you have a current backup of any important files before you reformat.

Using Disk Utility
The Mac OS X CD contains an application called Disk Utility that allows you to format
and partition your disk. This section guides you through the formatting and partition-
ing process. Choose the appropriate section below depending on whether the disk is
already partitioned and whether you want to end up with one or more volumes.

Erase a disk and create a single volume
This task completely erases all files and volumes from the disk, whether it currently
contains one or multiple volumes. A single large volume is created.

1. Make sure you have a backup copy of your important files.

2. Start up your computer from the Mac OS X Disc 1 CD. (To start the computer from a
CD, press the “c” key after you hear the startup chime and hold it until the Apple logo
appears on the screen.)

3. From the File menu, choose Open Disk Utility.

4. Click the Erase button.
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Formatting terms

Format (Erase). When you format or erase 
a disk, important data structures on the disk
are rewritten, effectively deleting all of the
files and folders it previously contained.

Partition. To divide a single hard disk into
two or more virtual drives, called volumes.
Each volume appears as a separate disk icon
in the Finder. (A partition is the same as a
volume.)

Volume. An entire unpartitioned hard drive
or a partitioned section of one.



5. Select the disk you want to erase from the list on the left side of the Disk Utility 
window. (In the list, volumes have names next to their icons; disks have sizes.)

6. In the Volume Format pop-up menu, choose Mac OS Extended.

7. In the Name field, enter a name for the volume that will be created.

8. Click the Install Mac OS 9 Drivers checkbox to install the drivers.

9. Click Erase to erase the disk.

Erase a disk and create multiple volumes
This task completely erases all the files from a disk. All existing volumes are erased 
and are replaced by new volumes that you define.

1. Make sure you have a backup copy of your important files.

2. Start up the computer from the Mac OS X Disc 1 CD. (To start the computer from a 
CD, press the “c” key after you hear the startup chime and hold it until the Apple logo
appears on the screen.)

3. From the File menu, choose Open Disk Utility.

4. Click the Partition button.

5. Select the disk you want to partition from the list on the left side of the Disk Utility
window. (In the list, volumes have names next to their icons; disks have sizes.)

6. In the Volume Scheme pop-up menu, select the number of volumes you want to create.

7. Change the size of the volumes by dragging the volume divider bars or by selecting a
partition and entering a value into its Size field.

8. Name each volume by selecting it and entering a name into its Name field.

9. Set the format of each volume to Mac OS Extended using the Format pop-up menu.

10. Click the Mac OS 9 Disk Drivers Installed checkbox to install the drivers.

11. Click Partition to partition the disk.

76Guide for Creative Professionals
Migrating to Mac OS X

To partition or not to partition?
For most Mac OS X users, a single partition
(or volume) is recommended. When you 
get a new Mac, it contains a single volume.
However, if you are accustomed to working
with multiple volumes in Mac OS 9, you can
continue to do so in Mac OS X.

Using a single volume on your drive simplifies
file organization. If you decide to partition
the drive, you need a good strategy. Think
about how you work and where you’re going
to store files. Then decide on an appropriate
size for each volume. If you don’t get the
sizes right, you may eventually end up with
one volume completely filled while another is
nearly empty. If this happens, you’ll have to
repartition the drive (erasing its contents) or
change the way you organize your files.

You can install Mac OS X on a drive that con-
tains multiple volumes. Mac OS X works in
any volume as long as there is enough space.
If necessary, you can erase the contents of
some volumes and retain the data on others.



Erase files from a single volume
This task completely erases all the files from a single volume of a partitioned system.
The volume is not resized, and other volumes on the disk are not affected.

1. Make sure you have a backup copy of your important files.

2. Start up the computer from the Mac OS X Disc 1 CD. (To start the computer from a CD,
press the “c” key after you hear the startup chime and hold it until the Apple logo
appears on the screen.)

3. From the File menu, choose Open Disk Utility.

4. Click the Erase button.

5. Select the volume you want to erase from the list on the left side of the Disk Utility 
window. (In the list, volumes have names next to their icons; disks have sizes.)

6. In the Volume Format pop-up menu, select Mac OS Extended.

7. In the Name field, enter a name for your volume.

8. Click Erase to erase the volume.

Additional Resources
You can find additional resources in the Apple Customer Support Library
(www.apple.com/support).

For more information on fixing file system errors, check
docs.info.apple.com/article.html?artnum=106464 or
docs.info.apple.com/article.html?artnum=107392.

For more information on repairing permissions, check
docs.info.apple.com/article.html?artnum=106712 or 
docs.info.apple.com/article.html?artnum=125109.

For more information on backing up your files, check
docs.info.apple.com/article.html?artnum=25498.
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Appendix G: Font Book

Mac OS X now includes Font Book, a separate application that provides a wide range
of powerful font management capabilities. If you are not currently using a third-party
font management application, it is recommended that you add your fonts to Font
Book. This will allow you to begin creating font sets, called collections, for specific
tasks, projects, and software applications.

Font Book displays fonts that are in any of the approved Mac OS X font locations. See
“Where to Install Fonts” on page 55 for more information on how to select the best
locations for your needs.

Font Collections
Font Book gives you the ability to create groups of fonts, called collections. These 
collections help to organize your fonts so that they are easier to find and integrate
into your workflow. Several collections are provided with Mac OS X; you can also 
create your own. Collections are mainly used in the Font panel to limit the fonts that
you view, but you can also use them to enable or disable large groups of fonts on
your system.
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Searching for fonts
Font searching in Mac OS X Panther enables
you to quickly find the fonts you need, even
with a library of thousands of fonts. You can
search for fonts by their family name, such as
Helvetica or Times, or by the typeface name,
such as Bold, Condensed, or Italic. The latter
can be very useful for finding the right style
of font even if you don’t know the name. In
the example below, a search for Condensed
Bold shows only those families and typefaces
with fonts that are both bold and condensed.



All Fonts collection
The default collection of fonts on your system is All Fonts. This collection shows all 
the fonts that are available to you on a particular computer, whether they’re installed
on the computer just for you or shared with everyone on the network. This is a special
collection because it displays fonts as they are stored and shared on your system.

• User. These fonts are installed in the user’s Fonts folder under Library. They are 
available only to the user who installs them.

• Computer. These fonts are installed in the System Fonts folder under
/System/Library/Fonts and in Library/Fonts and are shared with all users on 
the system.

• Network. If you are on a network with a server that shares fonts, those fonts appear 
in this collection.

How to Install Fonts in Font Book
There are two ways to add fonts to Font Book. With both options, fonts are automati-
cally activated when they’re installed. You can later disable specific fonts temporarily,
allowing you to control which fonts are active for a specific job without having to
physically remove the ones you don’t need.

Selecting in the Finder
To add a font to Font Book from the Finder, begin by viewing your available fonts in a
Finder window. Double-click the font you want to add. Font Book displays a preview of
the font. (If the font you want to add is a PostScript font, be sure to double-click the
screen font, not the printer font.) A pop-up menu above the font sample indicates the
available styles for that font.

To install the selected font, click Install Font. Where the font is installed depends on
the settings in your Font Book preferences.
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Organizing fonts in Font Book
If you’re a professional designer who deals
with thousands of fonts, creating collections
is the only way to organize your font libraries.
The following are some ways you can use
collections to manage large libraries.

• Alphabetically. Organize fonts in alphabeti-
cal groups, such as A–D, E–H, and so on. This
is the simplest method of organization, but it
allows for fast navigation when searching for
a font name.

• By project name. Create a collection of fonts
that you plan to use for a particular project,
so you see only the fonts you need.

• By client. Many clients require a specific set 
of fonts for all of their projects. Creating a
collection makes it easier to enable the fonts
you need when working on these projects.

Because you can create any number of 
collections, you can use all of these tech-
niques and more to organize your fonts.
Individual font families can be placed in 
multiple collections.



At the bottom of the preferences window is a checkbox labeled “Always copy font files
when installing.” If this preference is off (the default setting), any fonts that are installed
on the current hard drive by Font Book are moved into the designated installation
location, and any organization associated with the previous disk location or directory
is lost. If the font is on a separate volume, it is copied to the designated Font Book
installation location.

If the Classic environment is installed on your system, there are three possible locations
for fonts to be installed; the default behavior can be set through Font Book preferences
as described earlier. If Classic is not installed, the radio button “for Classic Mac OS” is still
available, but the installation defaults to “for all users of this computer,” and the font is
installed in the <startup volume>/Library/Fonts directory.

If “for me only” is selected, the installation location is ~/Library/Fonts/.

You can override the preferred installation location by dragging the font (or the folder
containing the font) directly to the desired location.

Dragging and dropping
Alternatively, you can drag a folder containing fonts into the Collection list in Font
Book. If only one folder is dragged to the list, the new collection maintains the name
of the top-level directory.
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Previewing fonts
Once a font is installed, you can preview it in
different ways from the Preview menu:

• Sample. Shows the font using a standard
alphabetical list of characters.

• Repertoire. Shows the entire list of characters
available in the font.

• Custom. Shows what a custom string of text
looks like in the font. (This is the only mode
that allows you to type into the preview 
window.)

In all font preview modes, you can zoom 
in and out to view a font in a wide range 
of sizes.



If two or more folders are dragged, the directories are combined into one set with a
new name assigned by Font Book. (Note that creating collections by dragging folders
from the Finder rather than selecting fonts from the font list may result in duplicate
fonts being added to Font Book. See the section “Duplicate Fonts” for tips on how to
handle duplicate fonts.) 

Disabling Fonts
With Font Book, fonts can be stored in the various font directories in Mac OS X 
without being activated. This activation and deactivation is controlled by Font Book;
you cannot tell the state of the font by viewing it in the Finder.

As mentioned earlier, fonts are automatically activated as soon as they are added to
Font Book. To disable a font (or an entire collection), simply select it and click the
Disable button at the bottom of the font or collection window.

(Note that there are two possible behaviors for the Disable button for a collection. If
the preference is set to “just the collection,” that font collection is disabled in the Mac
OS X Font panel. However, the fonts are still active for all other application menus. If
“all fonts in the collection” is selected, disabling turns off the collection and the fonts
in the collection.)

To reactivate a font or collection, select the desired item and click the Enable button
at the bottom of the window. The disabled font is marked as “Off” next to its name.
Font Book automatically toggles the button’s label between Disable and Enable as
appropriate.
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Duplicate Fonts
If you frequently receive groups of fonts for specific jobs, you should add the set, do
the job, then delete the set and the fonts associated with it before adding another set.
This will keep your System folder free of duplicate fonts.

However, if you do end up with duplicate fonts, Mac OS X appends numbers to their
names to avoid confusion. The number is incremented every time you add a font of
the same name to the same directory. For example, a prepress shop might load 10
jobs in a day. If all the sets contain Helvetica fonts, by the end of the day your font
folder will have 10 copies of Helvetica, labeled Helvetica through Helvetica–9 when
you view the folder in the Finder.

In the Font panel and in font lists, only the active Helvetica will show. Font Book,
however, gives you access to all of the duplicate fonts—although without the suffix
numbers that distinguish them in the Finder. Therefore, you need a way to select 
the desired version of Helvetica for each job you do. Font Book offers both automatic
and manual methods of activating a specific font from among duplicate fonts.

To automatically resolve duplicate fonts within Font Book, select Edit > Resolve
Duplicates. Be sure that you have not selected a font from the list before choosing
Resolve Duplicates. Font Book will automatically make the last font loaded in
~/Library/Fonts the active font.

Alternatively, you can resolve duplicate fonts manually. To do this, click the specific
font you want to activate, then choose Edit > Resolve Duplicates. The font you selected
will be activated, and all of the duplicates will be deactivated.

82Guide for Creative Professionals
Migrating to Mac OS X



Each duplicate font is replicated in every set. To help you tell the fonts apart when
you’re choosing one to activate, position your cursor over one of them in the list.
A yellow “hover note” appears that displays detailed information about the font,
including its location.

Whether you choose an active font from among the duplicates automatically or 
manually, you will see that all instances of the font except one have a dot next to 
their names. The one without the dot is the active font.

83Guide for Creative Professionals
Migrating to Mac OS X



Appendix H:
Additional Resources

With the powerful new features and refinements in Mac OS X Panther, it’s likely you
will have all the tools you need to migrate to, manage, and troubleshoot a Mac OS X 
system. However, there may be occasions when you need additional functionality for
specific print, design, publishing, or other creative tasks. This section lists a selection 
of Apple and third-party products that may be useful to you. Please note that this 
section is provided for informational purposes only; Apple neither endorses nor sup-
ports third-party products listed in this guide.

Websites
• www.apple.com/pro. Resources for creative professionals. Stories, information papers,

links to seminars, and more.

• www.apple.com/macosx. Information about Mac OS X Panther applications and 
featured technologies.

• www.apple.com/downloads. Software downloads for Mac OS X.

• www.apple.com/guide. An online catalog of more than 23,000 hardware and software
products for the Mac.

• www.info.apple.com. Apple’s support site and Knowledge Base for questions and 
troubleshooting.

• www.versiontracker.com. A commercial catalog site for Mac OS X software and
updates. Offers automatic notification of recently released updates.

• www.macosxlabs.org. Website for the Higher Education Mac OS X Lab Deployment
Initiative. The goal of Mac OS X Labs is to simplify the task of installing and maintain-
ing Mac OS X in computer labs.

Printed and electronic books
• www.apple.com/macosx/resources. Information about helpful books to get the most

out of Mac OS X.

• Mac OS X Panther Killer Tips (www.peachpit.com). A collection of tips and hidden
secrets for the pro who needs results fast.

• The Mac OS X Conversion Kit: 9 to 10 Side by Side, Panther Edition (www.peachpit.com).
Lefthand pages show how you did a particular task in Mac OS 9; righthand pages
show you how to accomplish the same task in Panther.

• The X Lab (www.thexlab.com). Troubleshooting Mac OS X, an advanced troubleshooting
resource.

• Panther Tips & Tricks (www.maclifestyle.com). Electronic book that helps you save time
learning how to use Mac OS X like a pro.
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Advanced font management
• FontAgent Pro (www.insidersoftware.com). Repairs and organizes fonts.

• Font Reserve and Suitcase (www.extensis.com). Tools to help you find, preview, and
activate the fonts you need quickly.

• Master Juggler (www.alsoft.com/MasterJuggler/index.html). A professional-level font
manager for Mac OS X that gives you access to your entire font library and lets you
store, preview, and activate only the fonts you want to use.

Font utilities 
• Adobe Type Manager Light (www.adobe.com). A free utility that allows your fonts to

look good at all sizes in Classic applications.

• Apple Font Tools (developer.apple.com/fonts/OSXTools.html). Free Mac OS X 
command-line tools.

Windows connectivity 
• Thursby Software (www.thursby.com). Mac and Windows networking software with

enhanced features.

File sharing
• SharePoints (www.hornware.com). Peer-to-peer solution that makes it easy to share

any Mac OS X folder.

File backup utilities
• Carbon Copy Cloner (www.bombich.com)

• Data Backup X (www.prosofteng.com/products/data_backup.php)

• FWB Backup ToolKit (www.versiontracker.com)

• Norton SystemWorks for Macintosh (www.symantec.com). Includes Retrospect Express.

• Retrospect (www.dantz.com)

• Tri-BACKUP (www.tri-edre.com)

Scanners
If your scanner is not directly supported by Mac OS X, here are some third-party
options:

• SilverFast Ai (www.silverfast.com)

• VueScan (www.hamrick.com)

Third-party scanner drivers are available at 
www.apple.com/downloads/macosx/drivers.

Maintenance utilities 
Mac OS X includes two disk repair utilities: Disk Utility and the command-line tool
fsck. See the article “About Using Disk Utility and fsck for File System Maintenance”
(docs.info.apple.com/article.html?artnum=106214) for guidelines on how and when 
to use each tool.

Always back up your data before running any disk maintenance or troubleshooting
software. Also check the developer’s site to ensure that any tool you plan to use is
compatible with your version of Mac OS X.
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• Disk Warrior (www.alsoft.com) 

• Drive 10 and Tech Tool Pro (www.micromat.com) 

• Font Cache Expunger (www.elara.com)

• Norton Utilities for Macintosh (www.symantec.com) 

• Panther Cache Cleaner (www.northernsoftworks.com)

• Printer Setup Repair (www.fixamac.net) 

Other tools
• Print Window (www.swssoftware.com). Allows you to print folder listings from 

the Finder.

• Trash It (www.nonamescriptware.com). An AppleScript script that force-deletes 
stubborn Trash items.

• WindowShade X (www.unsanity.com). Adds window-shade and other minimizing
enhancements to Finder windows.
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Appendix I:
Migration Checklist

1. Evaluate your hardware.
(This item is for upgraders only. If you are migrating to a new Macintosh, you can skip 
to Item 2.) 

Make sure your Mac is capable of running Mac OS X.

Does the computer have a processor upgrade card?

■■  No     ■■  Yes (will not work with Mac OS X)

Does it meet the following requirements?

■■  At least 128MB of physical RAM (1GB recommended)

■■  A built-in display or a display connected to an Apple video card

■■  At least 2GB of disk space (8GB recommended)

2. Check that your third-party hardware and peripherals will work 
with Mac OS X.

Item Built-in Mac OS X Third-party 
support driver needed

1. _____________________________________ ■■ ■■

2. _____________________________________ ■■ ■■

3. _____________________________________ ■■ ■■

4. _____________________________________ ■■ ■■

5. _____________________________________ ■■ ■■

6. _____________________________________ ■■ ■■

3. Evaluate your image editing and page assembly software.

Title Version Mac OS 9 Optimized for Latest version to 
only Mac OS X run in Mac OS X

1. ______________________ _______ ■■ ■■ _____________

2. ______________________ _______ ■■ ■■ _____________

3. ______________________ _______ ■■ ■■ _____________

4. ______________________ _______ ■■ ■■ _____________

5. ______________________ _______ ■■ ■■ _____________

6. ______________________ _______ ■■ ■■ _____________
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4. Evaluate your font management software.

Title Version Mac OS 9 Optimized for  Latest version to 
only Mac OS X run in Mac OS X

1. ______________________ _______ ■■ ■■ _____________

2. ______________________ _______ ■■ ■■ _____________

3. ______________________ _______ ■■ ■■ _____________

5. Evaluate your Internet applications.

Title Version Mac OS 9 Optimized for Latest version to 
only Mac OS X run in Mac OS X

1. ______________________ _______ ■■ ■■ _____________

2. ______________________ _______ ■■ ■■ _____________

3. ______________________ _______ ■■ ■■ _____________

4. ______________________ _______ ■■ ■■ _____________

5. ______________________ _______ ■■ ■■ _____________

6. ______________________ _______ ■■ ■■ _____________

6. Evaluate your business applications.

Title Version Mac OS 9 Optimized for  Latest version to 
only Mac OS X run in Mac OS X

1. ______________________ _______ ■■ ■■ _____________

2. ______________________ _______ ■■ ■■ _____________

3. ______________________ _______ ■■ ■■ _____________

4. ______________________ _______ ■■ ■■ _____________

5. ______________________ _______ ■■ ■■ _____________

6. ______________________ _______ ■■ ■■ _____________

7. Evaluate your extensions and control panels.
Check your extensions to make sure that Mac OS X has equivalent features (see 
page 9) and list those for which there is no equivalent. Check with the developers 
of these extensions to find out whether similar software is offered for Mac OS X.

Item Built-in Mac OS X Third-party 
support software needed

1. _____________________________________ ■■ ■■

2. _____________________________________ ■■ ■■

3. _____________________________________ ■■ ■■

4. _____________________________________ ■■ ■■

5. _____________________________________ ■■ ■■

6. _____________________________________ ■■ ■■
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8. Evaluate your AppleScript scripts.
List your AppleScript scripts. Once you have upgraded to Mac OS X, you will need to
make sure they still work.

1. ____________________________________________________________________________________ 4. ______________________________________________________________

2. ____________________________________________________________________________________ 5. ________________________________________________

3. ____________________________________________________________________________________ 6. ______________________________________________________________

9. Record your Mac OS 9 network settings.

TCP/IP settings

IP address (or DHCP): ______________________________________________________________________________________________________________________________________ DNS servers:__________________________________________________________________________________________________________________

Subnet mask (or DHCP): ______________________________________ Domain name: ______________________________________________________________________________________________________

Router (or DHCP): __________________________________________________ Not used: ■■  

PPP settings

IP address: ______________________ DNS servers: ________________________________________________________________________________________________________________

Subnet mask: __________________________ Domain name:______________________________________________________________________

Router: ________________________________ Not used: ■■  

PPPoE settings

Service provider: ____________________ Password: ________________________________________________________________________________________________________________________________________________________________________________________________________________________________

Account name: ____________________________ Not used: ■■  

AppleTalk settings

AppleTalk zone (if any): ____________ Node ID: ________________________________________________________________________________________________________________________________________________________________________________________________________________________________________

Network ID: ________________________

10. Record your email settings.

Email address: ______________________________________________________________________________________________________________________________________________________________________________________ Password: __________________________________________________

User name:________________________________________________________________________________________________________________________________________________________________________________________________________________ Incoming mail server: __________________________

Outgoing mail server: ________________________________________________________________________________________________________________________________ IMAP or POP account: ______________________________

11. Check off each of the final steps as you complete them.

■■  Back up your files.

■■  Verify your file system.

■■  Update Mac OS 9.

■■  Update firmware.

You are now ready to upgrade to Mac OS X or migrate to your new Mac OS X system.
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*Audio and video conferencing requires a compatible Internet service provider; fees may apply.
**Onsite repair coverage is not available in all locations.
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For More Information 
For more information about Mac OS X,
visit www.apple.com/macosx. Specific 
information about upgrading to Panther 
from earlier versions of the Mac OS is 
provided at www.apple.com/macosx/
upgrade/questions/howto.html.


